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Overview

This chapter covers:
B Productoverview.............
B Workflow overview . ..........
B Instrument and software overview

B Materials and equipment. . . .. ..
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Chapter 1 Overview

Product overview

Purpose

Product
description

About the primers

The AmpF(STR® NGM SElect™ PCR Amplification Kit is a short tandem repeat
(STR) multiplex assay that amplifies the 15 STR loci contained in the AmpF{(STR®
NGM™ kit together with the highly polymorphic SE33 (ACTBP2) locus and the
gender determination locus Amelogenin. The NGM SElect™ kit delivers a 17-locus
multiplex with the highest discrimination power of any AmpF(STR® kit and benefits
from the same improvements in sensitivity and robustness pioneered with the NGM™
kit. Like the NGM™ kit, the NGM SElect™ kit uses modified PCR cycling conditions
for enhanced sensitivity, a new buffer formulation to improve performance with
inhibited samples, more loci concentrated in the low molecular-weight region of the
profile to improve performance on degraded samples, and an improved process for
synthesis and purification of the amplification primers to deliver a much cleaner
electrophoretic background.

The AmpF(STR® NGM SElect™ Kit contains all the necessary reagents for the
amplification of human genomic DNA.

The reagents are designed for use with the following Applied Biosystems®
instruments:

* Applied Biosystems® 3500/3500xL Genetic Analyzer

+ ABI Prism® 3100/3100-4vant Genetic Analyzer

+ Applied Biosystems® 3130/3130x/ Genetic Analyzer

+  GeneAmp® PCR System 9700 with the Silver 96-Well Block

+  GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block
*  Veriti® 96-Well Thermal Cycler

+ ProFlex " PCR System

The AmpF(STR® NGM SElect™ Kit employs the latest improvements in primer
synthesis and purification techniques to minimize the presence of dye-labeled
artifacts. These improvements result in a much cleaner electropherogram
background that enhances the assay signal-to-noise ratio of the assay and simplifies
the interpretation of results.

10
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Product overview

Loci amplified by

the kit

The following table shows the loci amplified, their chromosomal locations, and the
corresponding fluorescent marker dyes. The AmpF(STR® NGM SElect™ Allelic
Ladder is used to genotype the analyzed samples. The alleles contained in the Allelic
Ladder and the genotype of the AmpF(STR® Control DNA 007 are also listed in the

table.
Table 1 AmpF(STR® NGM SElect™ Kit loci and alleles
. . Chromosome Alleles included in AmpF/STR® NGM Dye Control DNA
Locus designation location SElect™ Allelic Ladder label 007

D10S1248 10026.3 8,9,10, 11,12, 13, 14,15, 16, 17, 18 6-FAM™ 12,15

vWA 12p13.31 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, | 6-FAM™ 14,16
23,24

D16S539 16924.1 5,8,9, 10,11, 12,13, 14,15 6-FAM™ 9,10

D2S1338 2935 15,16, 17,18, 19, 20, 21, 22, 23, 24, 25, 6-FAM™ 20, 23
26, 27, 28

Amelogenin X: p22.1-22.3 X, Y VIC® X, Y

Y: p11.2

D8S1179 8024.13 8,910, 11,12, 13, 14, 15,16, 17, 18, 19 VIC® 12,13

D21S11 21q11.2-g21 24,24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, VIC® 28, 31
30.2, 31, 31.2, 32, 32.2, 33, 33.2, 34, 34.2,
35, 35.2, 36, 37, 38

D18S51 18921.33 7,9,10,10.2,11,12,13,13.2,14,14.2,15, | VIC® 12,15
16, 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27

D2251045 22q12.3 8,9,10,11,12,13, 14,15, 16, 17,18, 19 NED™ 11,16

D19S433 19qg12 9,10, 11,12,12.2, 13, 13.2, 14, 14.2, 15, NED™ 14,15
15.2,16,16.2,17,17.2

THO1 11p15.5 4,5,6,7,8,9,9.3,10, 11, 13.3 NED™ 7,9.3

FGA 4028 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, NED™ 24,26
27, 28, 29, 30, 30.2, 31.2, 32.2, 33.2, 42.2,
43.2,44.2,45.2,46.2,47.2,48.2,50.2, 51.2

D2S441 2pi14 9,10, 11,11.3,12, 13, 14, 15, 16 PET® 14,15

D3S1358 3p21.31 12,13, 14,15, 16,17, 18, 19 PET® 15,16

D1S1656 1g42.2 9,10, 11,12, 13, 14, 14.3, 15, 15.3, 16, PET® 13, 16
16.3,17,17.3, 18.3, 19.3, 20.3

D12S391 12p13.2 14,15,16, 17, 18, 19, 19.3, 20, 21, 22, 23, PET® 18, 19
24, 25, 26, 27

SE33 6 4.2,6.3,8,9,11,12,13,14,15, 16, 17, 18, PET® 17,25.2
19, 20, 20.2, 21, 21.2, 22.2, 23.2, 24.2,
25.2,26.2,27.2,28.2,29.2,30.2, 31.2,
32.2,33.2, 34.2, 35, 35.2, 36, 37
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Chapter 1 Overview

Allelic Ladder The Allelic Ladder for the AmpF(STR® NGM SElect™ Kit is shown below. See
profile “Allelic ladder requirements” on page 34 for information on ensuring accurate

genotyping.
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GeneMapper® ID-X Software plot of the AmpF/STR® NGM SElect™ Allelic Ladder
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Product overview

Control DNA 007  Amplification of Control DNA 007 using the AmpF(STR® NGM SElect™ Kit is
profile  shown below.
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1 ng of Control DNA 007 amplified with the AmpF{STR® NGM SElect™ Kit and
analyzed on the Applied Biosystems® 3130x/ Genetic Analyzer
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Chapter 1 Overview

Workflow overview

Extract DNA

-—
AutoMate Express™ Forensic DNA Extraction System with PrepFiler® Express™ Forensic DNA Extraction Kit

.

Quantify DNA

- — i
Quantifiler® Duo DNA Quantification Kit Quantifiler® HP and Trio DNA Quantification Kits
Perform PCR
w
96-Well GeneAmp® PCR System 9700 ProFlex™ PCR System Veriti® 96-Well Thermal Cycler

.

Perform electrophoresis

N——

Applied Biosystems® .
3500/3500xL Genetic Analyzer ABI PRISM® 3100/3100-Avant Genetic Applied Biosystems® 3130/3130x/

for Human Identification Analyzer Genetic Analyzer

.

Analyze data

'S Applied
AR AR s

GeneMapper® /D
Software v3.2.1
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Instrument and software overview

Instrument and software overview

Data Collection
and
GeneMapper® ID
or ID-X Software

Instrument and
software
compatibility

About
multicomponent
analysis

This section provides information about the Data Collection Software versions
required to run the AmpF(STR® NGM SElect™ PCR Amplification Kit on specific
instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data
Collection Software collects the data and stores it. The Data Collection Software
stores information about each sample in a sample file (.fsa), which is then analyzed
by the GeneMapper® ID or ID-X Software.

Table 2 Software specific to each instrument

Instrument Datgo(f:tcw:glon Analysis software
3500/3500xL 3500 Series Data GeneMapper® ID-X
Collection Software Software v1.2
v1.0 or later
3130/3130x/* 3.0 or later e GeneMapper® ID
Software v3.2.1
3100/3100- 1.1 (3100) or
Avant
1.0 (3100-Avant) o GeneMapper® ID-X
50 Software v1.0.1 or later

1 We conducted validation studies for the AmpF(STR® NGM SElect™ Kit using this
configuration.

Applied Biosystems fluorescent multi-color dye technology allows the analysis of
multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
overlapping loci are distinguished by labeling locus-specific primers with different
colored dyes.

Multicomponent analysis is the process that separates the five different fluorescent
dye colors into distinct spectral components. The four dyes used in the AmpF{(STR®
NGM SElect™ PCR Amplification Kit to label samples are 6-FAM™, VIC®, NED™,
and PET® dyes. The fifth dye, LIZ™, is used to label the GeneScan"" 600 LIZ™ Size
Standard v2.0.

AmpF&TR® NGM SElect™ PCR Amplification Kit User Guide 15



Chapter 1 Overview

How
multicomponent
analysis works

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on the Applied Biosystems® and ABI PRISM®
instruments, the fluorescence signals are separated by diffraction grating according
to their wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM™ dye emits at the shortest wavelength and it
is displayed as blue, followed by the VIC® dye (green), NED™ dye (yellow), PET®
dye (red), and LIZ™ dye (orange).

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes, as shown
in the spectra below. The goal of multicomponent analysis is to correct for spectral
overlap.

Dyes

6-FAM VIC NED PET LIZ
c 100 1 1 1 1 1
Ke) 4
3 80 -
g J
w 60 4
'8 i
N 40 -
© |
E 20 1 y_
@] 4
P4 0 —

T T T T T T T T T T T L B T T T T T

500 550 600 650 700

Wavelength (nm)

Emission spectra of the five dyes used in the AmpF(STR® NGM SElect™ Kit
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Materials and equipment

Materials and equipment

Kit contents and
storage

The AmpF(STR® NGM SElect™ PCR Amplification Kit contains materials
sufficient to perform 200 (PN 4457889) or 1000 (PN 4457890) amplifications at
25 uL reaction volumes.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer set from light when not in use. Amplified DNA, AmpF(STR®
NGM SElect™ Allelic Ladder, and GeneScan'" 600 LIZ™ Size Standard v2.0 should
also be protected from light. Keep freeze-thaw cycles to a minimum.

Table 3 Kit Contents and Storage

Component Description 200X Volume 1000X Volume Storage
AmpF(STR® NGM Contains forward and reverse 1 tube, 1.0 mL 1 bottle, 5.0 mL -15t0-25°Con
SElect™ Primer Set | primers to amplify human DNA receipt, 2to 8 °C

targets.

AmpFlSTR® NGM
SElect™ Master
Mix

Contains enzyme, salts, dNTPs,

2 tubes, 1.0 mL
each

1 bottle, 10.0 mL

after initial use

carrier protein, and 0.05%
sodium azide.

AmpFlSTR® NGM
SElect™ Allelic
Ladder

AmpF(STR®
Control DNA 007

Contains amplified alleles. 1 tube, 50.0 L 1 tube, 75.0 pL

See Table 1 on page 11 for a list
of alleles included in the Allelic
Ladder.

Contains 0.10 ng/pL human 2t08°C
male 007 DNA in 0.02% sodium

azide and buffer®.

1 tube, 0.3 mL 1 tube, 0.3 mL

See Table 1 on page 11 for
profile.

1 The AmpF(STR® Control DNA 007 is included at a concentration appropriate to its intended use as an amplification control (to provide
confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpF{STR® Control DNA 007 is not
designed to be used as a DNA quantitation control, and laboratories may expect to see variation from the labelled concentration when
quantitating aliquots of the AmpF(STR® Control DNA 007.

Standards for
samples

For information on ordering kits and materials not included, see Appendix B on
page 147.

For the AmpF{STR® NGM SElect™ Kit, the panel of standards needed for PCR
amplification, PCR product sizing, and genotyping are:

* Control DNA 007 — A positive control for evaluating the efficiency of the

amplification step and STR genotyping using the AmpF(STR® NGM SElect™

Allelic Ladder.

+ GeneScan'" 600 LIZ"™ Size Standard v2.0 — The following fragments should

be defined for use with the AmpF{(STR® NGM SElect™ Kit: 60, 80, 100, 114,

120, 140, 160, 180, 200, 214, 220, 240, 250, 260, 280, 300, 314, 320, 340, 360,

380, 400, 414, 420, 440 and 460. For additional information about size
standards, refer to the GeneMapper® ID Software Version 3.1 Human
Identification Analysis User Guide (PN 4338775), Appendix D. Order the
GeneScan'™ 600 LIZ™ Size Standard v2.0 (PN 4408399) separately.

AmpF&TR® NGM SElect™ PCR Amplification Kit User Guide
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Chapter 1 Overview

Materials and
equipment not
included

+  AmpF(STR® NGM SElect™ Allelic Ladder — Allelic ladder for accurate
characterization of the alleles amplified by the AmpF(STR® NGM SElect™ Kit.
The AmpF(STR® NGM SElect™ Allelic Ladder contains most of the alleles
reported for the 16 autosomal loci. See Table 1 on page 11 for a list of the
alleles included in the AmpF{STR® NGM SElect™ Allelic Ladder.

For information about required and optional materials and equipment not supplied
with the AmpF(STR® NGM SElect™ Kit, see Appendix B, “Materials and equipment
not included” on page 147.

18
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PCR Amplification
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PCR Amplification

This chapter covers:

B PCRWOTK Areas . . ......cooi it 22
B Required user-supplied materials and reagents. ... .................... 23
B DNA quantification. ... ...ttt 23
B Prepare the amplification kitreactions . . ............................ 25
B Perform PCR ... .. 26
B Amplification using bloodstained FTA® cards. . ...................... 27
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Chapter 2 PCR Amplification

PCR work areas

Work area setup
and lab design

PCR-setup tools

Amplified DNA
work area tools

Many resources are available for the appropriate design of a PCR laboratory:

+ For AmpF/(STR® NGM SElect™ PCR Amplification Kit forensic DNA testing,
refer to: National Institute of Justice Office of Law Enforcement Standards.
1998. Forensic Laboratories: Handbook for Facility Planning, Design,
Construction and Moving. Washington, DC: National Institute of Justice. 76 pp.

+ For AmpF/{STR® NGM SElect™ Kit parentage DNA testing, refer to: American
Association of Blood Banks. 2004. Guidance for Standards for Parentage
Relationship Testing Laboratories. T7th ed. Bethesda, Md: American Association
of Blood Banks. 58 pp.

The sensitivity of the AmpF{STR® NGM SElect™ Kit (and other PCR-based tests)
enables amplification of minute quantities of DNA, necessitating precautions to
avoid contamination of samples yet to be amplified (Kwok and Higuchi, 1989).

To prevent contamination by human DNA, be careful while handling and processing
samples. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: These laboratory design resources and guidances constitute only a sample of
the precautions that need to be observed when using PCR technology. Refer to your
laboratory’s internal policies and procedures for more information and references.

IMPORTANT! These items should never leave the PCR setup work area.

» Calculator, vortex

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5 mL, or 2.0 mL, or other appropriate clean tube (for
Master Mix preparation)

*  Microcentrifuge tube rack

* Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettors

» Tube decapper, autoclavable

* Vortex

The following PCR systems should be placed in the amplified DNA work area.

+  GeneAmp® PCR System 9700 with the Silver 96-Well Block

+  GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block
*  Veriti® 96-Well Thermal Cycler

» ProFlex™ PCR System

22
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Required user-supplied materials and reagents

Required user-supplied materials and reagents

Kit contents and The AmpF(STR® NGM SElect™ PCR Amplification Kit is available as either a
storage 200 reaction kit or 1000 reaction kit. The number of reactions is based on a 25 pL
reaction volume. See “Kit contents and storage” on page 17 for details on kit
contents.

User-supplied In addition to the AmpF(STR® NGM SElect™ Kit reagents, the use of low TE buffer
reagents (10 mM Tris, 0.1 mM EDTA, pH 8.0) is recommended. You can prepare the buffer as
described in the procedure below or order it from Teknova (Cat # T0223).

To prepare low TE buffer:

1. Mix together:
* 10mL of 1 M Tris-HCI, pH 8.0
* 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes based on your specific needs.

2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA quantification

Importance of Quantifying the amount of DNA in a sample before amplification allows you to

quantification determine whether or not sufficient DNA is present to permit amplification and to
calculate the optimum amount of DNA to add to the reaction. The optimum amount
of DNA for the AmpF{STR® NGM SElect™ Kit is 1.0 ng in a maximum input
volume of 10 pL at 29 cycles.

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by
the instrument (“off-scale” data). Off-scale data are problematic because:

— Quantification (peak height and area) for off-scale peaks is not accurate.
For example, an allele peak that is off-scale can cause the corresponding
stutter peak to appear higher in relative intensity, thus increasing the
calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

» Incomplete A-nucleotide addition.
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Chapter 2 PCR Amplification

Methods of
quantifying DNA

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur, resulting in a partial profile.

We provide several kits for quantifying DNA in samples. See the references cited in
the following table for details about these kits.

Product

Description

Quantifiler® Human DNA
Quantification Kit
(PN 4343895)

and

Quantifiler® Y Human
Male DNA Quantification
Kit

(PN 4343906)

For more information, see
Quantifiler® Human DNA
Quantification Kits User’s
Manual (PN 4344790)

Properties:

The Quantifiler® Human and Quantifiler® Y Human Male kits are highly specific for human
DNA, and they detect total human or male DNA, respectively. The kits detect single-
stranded and degraded DNA.

How they work:

The Quantifiler® DNA Quantification kits consist of target-specific and internal control 5'
nuclease assays.

The Quantifiler® Human and Quantifiler® Y Human Male kits contain different target-
specific assays (human DNA or human male DNA, respectively) that each consist of two
locus-specific PCR primers and one TagMan® MGB probe labeled with FAM™ dye for
detecting the amplified sequence. The kits each contain a separate internal PCR control
(IPC) assay that consists of an IPC template DNA (a synthetic sequence not found in
nature), two primers for amplifying the IPC template DNA, and one TagMan® MGB probe
labeled with VIC® dye for detecting the amplified IPC DNA.

Quantifiler® Duo DNA
Quantification Kit
(PN 4387746)

For more information, see
Quantifiler® Duo DNA
Quantification Kit User's
Manual (PN 4391294)

Quantifiler® HP DNA
Quantification Kit (Cat.
no. 4482911)

Quantifiler® Trio DNA
Quantification Kit (Cat.
no. 4482910)

For more information, see
Quantifiler HP and Trio
DNA Quantification Kits
User Guide (Pub no.
4485354)

Properties:

The Quantifiler® Duo kit is highly specific for human DNA and combines the detection of
both total human and male DNA in one PCR reaction.The kit detects single-stranded and
degraded DNA.

How it works:

The Quantifiler® Duo DNA Quantification Kit consists of target-specific and internal control
5' nuclease assays.

The Quantifiler® Duo kit combines two human-specific assays in one PCR reaction (for total
human DNA and human male DNA). The two human DNA specific assays each consist of
two PCR primers and a TagMan® probe. The TagMan® probes for the human DNA and
human male DNA assays are labeled with VIC® and FAM™ dyes, respectively. In addition,
the kit contains an internal PCR control (IPC) assay similar in principle to that used in the
other Quantifiler kits, but labeled with NED™ dye.

Properties:

The Quantifiler® HP Kit is designed to quantify the total amount of amplifiable human DNA
in a sample. The Quantifiler® Trio Kit is designed to simultaneously quantify the total
amount of amplifiable human DNA and human male DNA in a sample.

How they work:

The Quantifiler® HP and Trio DNA Quantification Kits use multiple-copy target loci for
improved detection sensitivity. The human-specific target loci (Small Autosomal, Large
Autosomal, and Y-chromosome targets) each consist of multiple copies dispersed on
various autosomal chromosomes (Small Autosomal and Large Autosomal).

To maximize the consistency of quantification results, genomic targets were selected with
conserved primer- and probe-binding sites within individual genomes and also with
minimal copy number variability between different individuals and population groups. As a
result, the detection sensitivity of the Quantifiler® HP and Trio assays is improved over
Quantifiler® Duo, Human, and Y Human Male DNA Quantification Kit assays. The primary
quantification targets (Small Autosomal and Y) consist of relatively short amplicons (75 to
80 bases) to improve the detection of degraded DNA samples. In addition, the Quantifiler®
HP and Trio Kits each contain a Large Autosomal target with a longer amplicon (>200
bases) to aid in determining if a DNA sample is degraded.
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Prepare the ampilification kit reactions

Prepare the amplification kit reactions

1. Calculate the volume of each component needed to prepare the reactions, using

the table below.
DNA sample Volume per reaction
AmpF(STR® NGM SElect™ Master Mix 10.0 uL
AmpF(STR® NGM SElect™ Primer Set 5.0 uL

Note: Include additional reactions in your calculations to provide excess
volume for the loss that occurs during reagent transfers.

2. Prepare reagents. Thaw the AmpF(STR® NGM SElect™ Master Mix and the
AmpF/{STR® NGM SElect™ Primer Set, then vortex the tubes for 3 seconds and
centrifuge them briefly before opening.

IMPORTANT! Thawing is required only during first use of the kit. After first
use, reagents are stored at 2 to 8 °C and, therefore, do not require subsequent
thawing. Do not refreeze the reagents.

3. Pipette the required volumes of components into an appropriately-sized
polypropylene tube.

4. Vortex the reaction mixture for 3 seconds, then centrifuge briefly.

5. Dispense 15 uL of reaction mixture into each reaction well of a MicroAmp®
Optical 96-Well Reaction Plate or each MicroAmp® tube.

6. Prepare the DNA samples as shown in the table below. The final reaction
volume should be 25 pL.

DNA sample To prepare...

Negative control Add 10 pL of low TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0).

Test sample Dilute a portion of the test DNA sample with low TE buffer so
that 1.0 ng of total DNA is in a final volume of 10 pL. Add 10 pL
of the diluted sample to the reaction mix.

Positive control Add 10 uL of 007 control DNA (0.1 ng/pL) to provide 1.0 ng of
total DNA in the positive control reaction.

7. Seal the MicroAmp® Optical 96-Well Reaction Plate with MicroAmp® Clear
Adhesive Film or MicroAmp® Optical Adhesive Film, or cap the tubes.

8. Centrifuge the tubes or plate at 3000 rpm for about 20 seconds in a tabletop
centrifuge (with plate holders, if using 96-well plates) to remove bubbles.
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Perform PCR

9. Amplify the samples in a GeneAmp® PCR System 9700 with the silver 96-well

block, or a GeneAmp® PCR System 9700 with the gold-plated silver 96-well
block, a Veriti® 96-Well Thermal Cycler, or a ProFlex " PCR System.

Note: The AmpF(STR® NGM SElect™ Kit is not validated for use with the
GeneAmp PCR System 9700 with the aluminium 96-well block. Use of this
thermal cycling platform may adversely affect the performance of the
AmpF(STR® NGM SElect™ Kit.

. Program the thermal cycling conditions.

*  When using the GeneAmp PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

»  When using the Veriti® 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti® 96-Well Thermal
Cycler AmpF&STR® Kit Validation (Part no. 4440754).

+  When using the ProFlex™ PCR System, refer to the ProFlex" PCR System
Kit Validation User Bulletin (Pub. no. 100031595) for more information.

Initial Cycle (29 or 30 cycles) Final Final
incubation step extension hold
Denature ‘ Anneal
HOLD CYCLE HOLD HOLD
95 °C 94 °C 59 °C 60 °C 4°C
11 minutes 20 seconds = 3 minutes 10 minutes indefinite

IMPORTANT! The AmpF/STR® NGM SElect™ Kit is validated for use at both
29 and 30 cycles. The optimum conditions for the NGM SElect™ kit are 29
cycles of amplification with a 1 ng input DNA concentration. Laboratories
choosing to use the NGM SElect " kit at 30 cycles should reduce the input DNA
concentration to 500 pg. Internal validation studies to evaluate all aspects of kit
performance are required for each individual cycle number intended for
operational use within the laboratory.

. Load the plate or tubes into the thermal cycler and close the heated cover.

IMPORTANT! Ifusing adhesive clear film instead of caps to seal the plate wells,
be sure to place a MicroAmp® compression pad (PN 4312639) on top of the
plate to prevent evaporation during thermal cycling.

3. Start the run.
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Amplification using bloodstained FTA® cards

4. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
< 2 weeks 2t08°C
> 2 weeks -15to25°C

IMPORTANT! Store the amplified products so that they are protected from light.

Amplification using bloodstained FTA® cards

2800
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1600
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400

100

FTA® cards can be useful for the collection, storage, and processing of biological
samples. A small punch disc of the card containing the sample can be placed directly
into an amplification tube, purified, and amplified, without transferring the disc. Our
studies indicate that a 1.2 mm bloodstained disc contains approximately 5 to 20 ng
DNA. An appropriate cycle number for this high quantity of DNA is 24 cycles,
determined by our validation studies. However, it is recommended that each
laboratory determine the optimum cycle number based on internal validation studies.

In the example shown in Figure 1, a 1.2 mm disc of a bloodstained FTA® card was
purified using three washes with FTA® Purification Reagent and two washes with
1X low TE buffer. The punch was then amplified directly in the MicroAmp® tube for
24 cycles.

J.Nﬂ. A i A Mil ' I k

Figure 1 AmpF(STR® NGM SElect™ PCR Amplification Kit results from a 1.2 mm
FTA® bloodstain disc (24-cycle amplification), analyzed on an Applied
Biosystems® 3130x/ Genetic Analyzer
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Electrophoresis

This chapter covers:

B Allelic ladder requirements . . . . ..ottt 34

Section 3.1 3100/3100-Avant and 3130/3130x] instruments ............. 35
B Set up the 3100/3100-Avant or 3130/3130x] instrument for electrophoresis . 35
B Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130xI1
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Chapter 3 Electrophoresis

Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples. Run the appropriate number of allelic ladder samples per injection
and per sample for your instrument:
+ Applied Biosystems® 3500 Series Genetic Analyzers:
Run at least one allelic ladder per every set of 24 samples.
— Applied Biosystems® 3500xL
One ladder per injection
One injection = 24 samples (23 samples + 1 allelic ladder)
— Applied Biosystems® 3500
One ladder for every 3 injections
One injection = 8 samples
« ABI PrRisM® 3100 and Applied Biosystems® 3130 Series Genetic Analyzers:
Run at least one allelic ladder per every set of 16 samples.
— Applied Biosystems® 3130x/ or ABI PRISM® 3100 systems
One ladder per injection
One injection = 16 samples
— Applied Biosystems® 3130 or ABI PRISM® 3100-Avant
One ladder for every 4 injections
One injection = 4 samples

IMPORTANT! Variation in laboratory temperature can affect fragment migration
speed and result in sizing variation. We recommend the indicated frequency of allelic
ladder injections; this frequency should account for normal variation in run speed.
However, during internal validation studies, verify the required allelic ladder
injection frequency to ensure accurate genotyping of all samples in your laboratory
environment.

When genotyping, it is important to use an allelic ladder run under the same
conditions as the samples because:

» Size values obtained for the same sample can differ between instrument
platforms because of different polymer matrices and electrophoretic conditions.

* Variation in laboratory temperature can affect migration speed (see
IMPORTANT above). These variations can result in sizing variations between
both single and multiple capillary runs, with a greater size variation between
those samples injected in multiple capillary runs, than between those samples
injected in a single capillary run.
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Section 3.1 Electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x/
instruments

Set up the 3100/3100-Avant or 3130/3130x/ instrument for
electrophoresis

Reagents and

Appendix B, “Materials and equipment not included” on page 147 lists the

parts required materials not supplied with the AmpF{(STR® NGM SElect™ PCR
Amplification Kit.
IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the AmpF(STR® NGM SElect™ Primer Set from light when not in use.
Amplified DNA, AmpF(STR® NGM SElect™ Allelic Ladder, and GeneScan"" 600
LIZ™ Size Standard v2.0 should also be protected from light. Keep freeze-thaw
cycles to a minimum.
3100/3100-Avant The following table lists Data Collection Software and the run modules that can be
or 3130/3130x/ used to analyze AmpF{STR® NGM SElect™ Kit PCR products. For details on the
instrument procedures, refer to the documents listed in the table.
requirements
Genetic Data Operating
Analyzer Collection System Run modules and conditions References
Y Software y
Applied 3.0% Windows® HIDFragmentAnalysis36_POP4_1 Applied Biosystems®
Biosystems XP Injection conditions: 3130/3130xI Genetic Analyzers
3130/3130x/ 130 = 3 KV/ Using Data Collection Software
- 3130=3 5 sec v3.0, Protocols for Processing
— 3130x/ = 3 kV/10 sec AmpF&STR PCR Amplification
Dye Set G5 Kit PCR Products User Bulletin
(PN 4363787)
ABI PRisM® | 2.0 Windows® HIDFragmentAnalysis36_POP4_1 ABI Prism® 3100/3100-Avant
3100 2000 Injection condition: 3kV/10 sec Genetic Analyzers Using Data
Dve Set G Collection Software v2.0,
ye Set G5 Protocols for Processing
AmpF&TR PCR Amplification
Kit PCR Products User Bulletin
(PN 4350218)
ABI Prism® 1.1 Windows GeneScan36vb_DyeSetG5Module | ABI PrisM® 3100/3100-Avant
3100 NT® Genetic Analyzers Protocols for

Injection condition: 3kV/10 sec
GS600v2.0Analysis.gsp

Processing AmpF&STR PCR
Amplification Kit PCR Products
User Bulletin (PN 4332345)
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Section 3.1 Electrophoresis

Genetic Coﬁ:tt:ion Operating Run modules and conditions References
Analyzer System
Software
ABI Prism® 1.0 Windows e GeneScan36Avb_DyeSetG5Module = ABI Prism® 3100/3100-Avant
3100-Avant NT® Injection condition: 3 kV/5sec Genetic Analyzers Protocols for
. Processing AmpF&STR PCR
* (GS600v2.0Analysis.gsp Amplification Kit PCR Products
User Bulletin (PN 4332345)

1 We conducted validation studies for the AmpF(STR® NGM SElect™ Kit using this configuration.
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Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130xI instrument

Prepare samples for electrophoresis on the 3100/3100-
Avant or 3130/3130x/ instrument

Prepare the samples for electrophoresis on the 3100/3100-4vant or 3130/3130x/
instrument immediately before loading.

1. Calculate the volume of Hi-Di" Formamide and GeneScan™ 600 LIZ™ Size
Standard v2.0 needed to prepare the samples, using the table below.

Reagent Volume per reaction
GeneScan™ 600 LIZ™ Size Standard v2.0 0.5 uL
Hi-Di™ Formamide 9.5 uL
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Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results/experiments.

2. Pipette the required volumes of components into an appropriately-sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:
* 10 pL of the formamide: size standard mixture
* 1 pL of PCR product or allelic ladder

Note: For blank wells, add 11 pL of Hi-Di"™ Formamide.

5. Seal the reaction plate with appropriate septa, then centrifuge the plate to ensure
that the contents of each well are collected at the bottom.

6. Heat the reaction plate in a thermal cycler for 3 minutes at 95 °C.

7. Immediately place the plate on ice for 3 minutes.

8. Prepare the plate assembly, then place onto the autosampler.

9. Ensure that a plate record is completed and link the plate record to the plate.

10. Start the electrophoresis run.
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Chapter 3

Section 3.2 3500/3500xL Series instruments

Set up the 3500/3500xL instrument for electrophoresis

Reagents and Appendix B, “Materials and equipment not included” on page 147 lists the
parts required materials not supplied with the AmpF(STR® NGM SElect™ PCR
Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the AmpF{STR® NGM SElect™ Primer Set from light when not in use.
Amplified DNA, AmpF(STR® NGM SElect™ Allelic Ladder, and GeneScan™" 600
LIZ™ Size Standard v2.0 should also be protected from light. Keep freeze-thaw
cycles to a minimum.

3500 instrument  The following table lists Data Collection Software and the run modules that can be
requirements used to analyze AmpF{STR® NGM SElect™ Kit PCR products. For details on the
procedures, refer to the documents listed in the table.

Genetic Data Operating
Collection Run modules and conditions References
Analyzer System
Software
Applied 3500 Data =~ Windows® e HID36_POP4 Applied Biosystems®
Biosystems® = Collection = XP Injection conditions: 1.2kV/15 sec 3500/3500xL Genetic Analyzer
3500 Software User Guide (PN 4401661)
vi.0 or ¢ Dye Set G5 )
. Wind 3500 and 3500xL Genetic
_Applied Vilsrt1a ows e HID36_POP4 Analyzers Quick Reference
Biosystems Injection conditions: 1.2kV/24 sec = Card (PN 4401662)
3500xL
¢ Dye Set G5
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Prepare samples for electrophoresis on the 3500/3500xL

Instrument
Prepare the samples for capillary electrophoresis on the 3500/3500xL instrument
immediately before loading.
1. Calculate the volume of Hi-Di"™ Formamide and GeneScan™ 600 LIZ™ Size
Standard v2.0 needed to prepare the samples, using the table below.
Reagent Volume per reaction
GeneScan™ 600 LIZ™ Size Standard v2.0 0.5 uL
Hi-Di™ Formamide 9.5 uL
Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.
IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.
2. Pipette the required volumes of components into an appropriately sized
polypropylene tube.
3. Vortex the tube, then centrifuge briefly.
4. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, or each
MicroAmp® optical strip tube, add:
* 10 pL of the formamide:size standard mixture
* 1 pL of PCR product or allelic ladder
Note: For blank wells, add 11 uL of Hi-Di"™ Formamide.
5. Seal the reaction plate or strip tubes with the appropriate septa, then centrifuge
to ensure that the contents of each well are collected at the bottom.
6. Heat the reaction plate or strip tubes in a thermal cycler for 3 minutes at 95 °C.
7. Immediately put the plate or strip tubes on ice for 3 minutes.
8. Prepare the plate assembly, then put it onto the autosampler.
9. Ensure that a plate record is completed and link the plate record to the plate.
10. Start the electrophoresis run.
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Data Analysis

This chapter covers:

Section 4.1 GeneMapper®ID Software ............cccvvevveeeennnn.. 47
B Before you start. .. ...t 47
m Set up GeneMapper® ID Software for data analysis . ................... 48
B Analyze and edit sample files with GeneMapper® ID Software. .......... 60
B For more information. . .. ......... ... 61
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Section 4.1 Data Analysis

Section 4.1 GeneMapper® ID Software

Before you start

GeneMapper® ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis. After electrophoresis, the Data
Collection Software stores information for each sample in a .fsa file. Using
GeneMapper® ID Software v3.2.1 software, you can then analyze and interpret the
data from the .fsa files.
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Note: Refer to “Instrument and software overview” on page 15 for a list of
compatible instruments.

When using GeneMapper® ID Software v3.2.1 to perform human identification
(HID) analysis with AmpF(STR® kits, be aware that:

» HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided that you
conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a
run folder.

» Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

* Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

* Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

* Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder
(OL) alleles may contain full and/or partial repeat units. An off-ladder allele is
an allele that occurs outside the £0.5 nt bin window of any known allelic ladder
allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory’s protocol.
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If you are using GeneMapper® ID-X Software to perform Human Identification
(HID) analysis with AmpF{STR® kits, go to “Set up GeneMapper® ID-X Software”
on page 64 or refer to the GeneMapper® ID-X Software Version 1.0 Human
Identification Analysis Getting Started Guide (PN 4375574).

Set up GeneMapper® ID Software for data analysis

Workflow To analyze sample (.fsa) files using GeneMapper® ID Software v3.2.1 for the first
time:

* Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 48.

* Create an analysis method, as explained in “Create a HID analysis method”
on page 52.

* Create a size standard, as explained in “Create a HID size standard” on
page 58.

* Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2
Human Identification Analysis Tutorial (PN 4335523) for more information.
* Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID Software Versions 3.1 and 3.2
Human Identification Analysis Tutorial (PN 4335523) for more information.

Import panels  To import the AmpF(STR® NGM SElect'" Kit panel and bin set from our website
and bins into the GeneMapper® ID Software v3.2.1 database:

1. Download and open the file containing panels and bins:

a. From the Support menu of www.appliedbiosystems.com, select
Support » Software Downloads, Patches & Updates » GeneMapper® ID
Software v 3.2 » Updates & Patches, and download the file NGMSElect
Analysis Files GMID.

b. Unzip the file.

2. Start the GeneMapper® ID Software, then log in with the appropriate user name
and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID Software
Version 3.1 Human Identification Analysis User Guide (PN 4338775).

3. Select Tools » Panel Manager.

4. Import NGMSElect_panel_v1:

a. Select Panel Manager in the navigation pane.
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Set up GeneMapper® ID Software for data analysis

(®)Panel Manager
File Edit Bins Yiew

wd BN NN A |

B Panel Manager

b. In the toolbar, select File » Import Panels to open the Import Panels

dialog box.

c. Locate, then open the NGMSElect Analysis Files GMID folder that you
unzipped in step 1b on page 48.

d. Select NGMSElect_panel_vl.txt, then click Import.

mport Panels

- BeEE

File narme: INGMSEIect _panel_wl i

Imnpart |

Files of type: IA” File:=

LI Cancel |

Note: Importing this file creates a new folder in the navigation pane of the
Panel Manager, AmpFLSTR_NGMSElect_v1. This folder contains the

panel and associated markers.

5. Import NGMSElect_bins_v1:

a. Select the AmpFLSTR_NGMSElect_v1 folder in the left navigation

pane.

(#)Panel Manager
Filz Edit Bins ‘iew

SF < || B W || | | |5inset

R

E-E=IPanel Manager

Pare]l Hame

Corarient

[T ampFLSTR _Panels_w1 1

B AmpFLETR_NGMSElect

GMWZElect_panel_wi

il

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Locate, then open the NGMSElect Analysis Files GMID folder.
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Section 4.1 Data Analysis

File Edit Bins ‘iew

Import Bin Set il

Laak in:

d. Select NGMSElect_bins_vl1, then click Import.

|I:| HEMSElect_GMID_v3.2_files

al

NGMSElect_panel_wl bt

Irmport |
ll Cancel |

File name: INGMSEIect_bins_v1 Tt

Files of type: [ Fites

Note: Importing this file associates the bin set with the panels in the
NGMSElect_panel_v1 folder.

6. View the imported panels in the navigation pane:

Double-click the AmpFLSTR_NGMSElect_v1 folder to view the
NGMSElect_panel_v1 folder.

Double-click the NGMSElect_panel_v1 folder to display the panel
information.

| R | [

il || B ® K || .l. ||Elin Set: INGMSEIec‘t_bins_ﬂ

- =IPansl Managsr Marker Hame  |Dye Color | Min Sim | Max Size | Conrol Alleles Marker | Miker § | Conomerts Ladder #Tleles
CJampFLETR_Panels_v1 1 PTos1zds |kblue 720 1270|1215 4 01204 [none BI1011121314 151617
SHES AmpFLETR_NGMSElsct_vi 2 | blue 1490 2143|1418 4 01118 |none 1,12,13,14,15,16,17,18,19,
T L1051 205 3 |D1BS539 blue 2236 |277E |90 4 00987 |none 5891011,12131415
L nin, 4 |D2s1338 blue 2816 (3860 [20,23 4 01232 [none 1516,17 18,19,20 21 22,23,
—D165539 5 |AMEL green 100.0 1058.0 Xy 9 oo none Y
—D251338 £ |DEs1179 green (1179 [1749  |1213 4 0.0993 |none 89,10,11,12,13,14,15 16,17
:gg“::ﬂg 7 |D21511 green (1788|2498  [2831 4 01043 [none 24,24 2,25 26,27 28 262,29
| D11 g |D18551 green (2595 |3475 [1215 4 01381 [none 781010.2111213132.1¢
—Diasst 9 |D2251045 yelow 760 1200|1116 3 01714 |hone 891011,1213141516,17
—h22E1043 10 |D195435 yellows (1223 1663 14,15 4 01102 none 31011,4212.21313.2,14,
:?;315433 11 |THM yelow 1764|2211 |793 4 0.0493 |none 4567589931011,133
L Foa 12 |FGA yelow  |2216  |3720  |24,26 4 01152 [none 17 16,1920, 21,22 23 24,25,
— D254 13 |D25441 red 745 1134 1415 4 0.0903 |none 910,11,11.312,13,14 1516
—DEE1358 14 0331358 red 1144 |1634 1516 4 0113 |none 121314151617 16,19
:g:f;g;ﬁ 15 |D151656 red 1700|2240 1318 4 0136 |none 9101112131414 31515
L zpas 16 |D125391 red 2250 2870 1813 4 01477 [none 14151617 16,1919.3,20,2
17 |SE33 red 2950 (4400 [17,252 4 01512 [none 42638911121314151
— =IReference Samples
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Set up GeneMapper® ID Software for data analysis

c. Select D10S1248 in the left navigation pane to display the Bin view for the
marker.

E:;Panel Manager x|
Fil= Edit EBins ‘iew

B || B W || |I||!ﬂ!||BinSet INGMSEIect_binS_N L|||. B B BB M |||i|ilili .l.l

[=-EJPanel Manager
[T ampFLSTR_Panels_vl

7 =) g 10 11 12 12 14 15 16 17 18 19 20

EfE= AmpFLSTR_NGMSElect_v1 10 ®
EHES NGMSElect_pansl_v1 o
D1051245 ()
vryr 0a gga
— D16S539 o
- Dostass 0s 8
— AMEL 5
—D8s1179 5
D211 07 P
— D1asst e}
— D2251045 g
- D195433 0g )
— THO1 1)
—FGa
— D254 s
- D331356
— D151656 04
— D125381
L33
= 03
—E=IReference Samples
02
0.1
0o
& ™ 75 79 @3 &r @ 95 93 103 107 111 115 119 123 127 13
010512492
o b

Ok | Cancel | Apply |

7. Click Apply, then click OK to add the AmpF(STR® NGM SElect™ Kit panel
and bin set to the GeneMapper® /D Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply and then
OK, the panels and bins are not imported into the GeneMapper® ID Software

database.
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Create a HID
analysis method

The HID Advanced analysis method for the AmpF¢STR® NGM SElect™ Kit uses the
NGMSElect_bins_v1 file described in step 5 on page 49.

Use the following procedure to create a HID analysis method for the AmpF(STR®
NGM SElect™ Kit.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

[#)GeneMapper Manager |
Projects  &nalysis Methods | Table Settings | Plot Settings I Matrices I Size Standards
Mame Last Saved Cravner Instrument Analysis Type Descri
HID_Advanced 2009-06-18 16:22:2 | grnid HIC =
HID_Clazsic 2007-08-06 10:03:0| gyenict HIC
Microzatellite Defaut 2004-05-28 11:34:3 | grnid Microzstelite Facton -

2. Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.

3. Select HID and click OK to open the Analysis Method Editor with the General
Tab selected.

4. The figures below show the settings for each tab of the Analysis Method Editor.
Configure settings as shown unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings (See
step 5 on page 57). To complete this step quickly, do not save the analysis
method until you finish entering settings in all of the tabs.
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General tab settings

Analysis Method Editor - HID x|
General | Alisle | Peak Detector | Pesk Qualty | Qualty Fiags |
—&ralysis Method Description
Marme: MGEMSElect_Analysishethod_ w1
Description: ﬂ
(@)
o
[ 3
<
)
Izt it I %
nistrunett:
@
@
Analysis Type:  HID O
()
o
—
=
o
()
Ok Cancel

In the Name field, either type the name as shown for consistency with files
supplied with other AmpF(STR® kits, or enter a name of your choosing. In the
Security Group field, select the Security Group appropriate to your software
configuration from the dropdown list. The Description and Instrument fields are

optional.
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Allele tab settings

Analysis Method Editor - HID x|

General Allele | Peak De‘fedorl Peak Gualﬂyl Cuality Flagsl

Bin et NGMSElect_bins_wi
v lse marker-specific stutter ratio if available

Marker Repesat Type Tri Tetra Perita Hexa

Cut-off Yalue fo.0 fo.0 fo.0 fo.0

Minus A Ratin oo oo oo oo

Minus& Distance From |o.0 fo.0 fo.0 fo.0
To oo oo oo oo

Minus Stuitter Ratio fo.0 fo.0 fo.0 fo.0

Minus Stutter Distance  From  [2.25 [5.25 oo oo
To |15 Ja.75 fo.0 fo.0

Plus Stutter Ratio jpor1 | Joo oo oo

Plus Stutter Distance  From  [2.25 fo.0 fo.0 fo.0
To 375 oo oo oo

Arnelogenin Cutoff IF

Range Fitter .. | Factory Defaults |

Qk | Cancel |

In the Bin Set field, select the NGMSElect_bins_v1 bin set imported
previously and configure the stutter distance parameters as shown.

GeneMapper® ID Software v3.2.1 allows you to specify four types of
marker repeat motifs: tri, tetra, penta, and hexa. You can enter parameter
values for each type of repeat in the appropriate column.

The “Use marker-specific stutter ratio if available” check box is selected by
default. Consequently, the software applies the stutter ratio filters supplied
in the NGMSElect_panel_v1 file. GeneMapper ID Software v3.2.1
specifies locus-specific filter ratios for minus stutters, but not for plus
stutters, in the panel file. However, validation studies with the NGM
SElect™ kit show that the trinucleotide repeat D22S1045 locus produces a
relatively large amount of plus stutter compared to tetranucleotide repeat
loci. The relatively large amount of stutter may cause the stutter peak to be
labeled during routine analysis.

The plus stutter at the D22S1045 locus can be filtered by assigning a global
plus stutter filter for trinucleotide repeat loci in the Analysis Parameter file.
Because D22S1045 is the only trinucleotide repeat locus in the NGM
Select™ kit, this stutter filter setting is applied only to plus stutter peaks at
the D22S1045 locus. The settings shown above resulted in little or no
labeling of D22S1045 plus stutter peaks during validation studies.
However, we recommend that users determine the settings appropriate for
use in their laboratory during internal validation studies.
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Peak Detector tab settings

Analysis Method Editor - HID x|

General | Allels Peak Detector | peak Guaity | cusity Flags |

Peak Detection Algorithim: IAdvanced LI
~Ranges —Peak Detection
Analysis Sizing Peak Amplitude Thresholds:
Full Range LI IAII Sizes LI B: I TBD R: I TEBD CGD)
p— o H Y
Start P 0 Start Size0 o)
o " o 6| TBD o TBD =
ap P of Size [
¥ | TBD 2
—Smoathing and Bazelining (0]
Win. Pieak Half Width: |2 pts )
Smaothing ™ MNone I S
i P 3
ol Light Palynomial Degree: o
" Heawy Peak Window Size: 15 pnts %
S S
Bazeling Wincow: IS'I pt= =lape Threshold L
Peak Start: IU-U @
—Zize Calling Method Peak End: IEI.D
' 2nd Order Least Squares
" 3rd Order Least Squares
' Cubic Spline Interpalation
¥ Local Southern Method
" Global Southern Method
Factary Defauts |

O | Cancel |

IMPORTANT! TBD indicates values to be determined in your laboratory.
Laboratories must perform the appropriate internal studies to determine the
peak amplitude thresholds for interpretation of NGM SElect™ kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to
specify the minimum peak height, in order to limit the number of detected
peaks. Although GeneMapper® ID Software displays peaks that fall below
the specified amplitude in electropherograms, the software does not label
or determine the genotype of these peaks.

+ Size calling method — The NGM SElect™ kit has been validated using the
Local Southern sizing method. Alternative sizing methods should be
selected only after extensive evaluation as part of an internal validation
study in the user’s laboratory.
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Peak Quality tab settings

Analysis Method Editor - HID x|

General | Allels | Peak Detector Peak Quaity | Guaity Flags |

—Signal level

Homozygous min pesk height I TED
Heterozygous tin peak height I TED

—Heterozyoote balahce
lin peak height ratio ID.?
—Peak marphalogy

Max peak width (basepairs) I‘I 1

—Pull-up pesk

Pull-up ratio 0.05

~&llele number

Max expected aleles |2

Factary Defaultts |

O | Cancel |

IMPORTANT! TBD indicates values to be determined in your laboratory.
Laboratories need to perform the appropriate internal validation studies to
determine the minimum heterozygous and homozygous minimum peak height
thresholds and the minimum peak height ratio threshold that allow for reliable
interpretation of AmpF(STR® NGM SElect™ Kit data.
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Quality Flags tab settings

Analysis Method Editor - HID x|

General | Allels | Peak Detector | Peak Guaity Gualty Flags |

Quality weights are betvween 0 and 1 .
—Euality Flag Settings

Spectral Pull-up IF Control Concordance IT
Broal Peak IF Loy Peak Height IF
Qut of Bin Allele IF Off-scale IF
Sl e Peak Height Ratio [

Qo
o
>
()
<
D
e
ie]
o
S
<)
)
(72
o
=4
=
=
()

~PE% Thresholds

Sizing Guslity: Fram ID.?S to 1.0 From 0.0 1o

IU.25
Genotype Quality: Fraom I':|-7"5 ta1.0 Fram 0.0 to IU.25

Factary Defauts |

O | Cancel |

IMPORTANT! The values shown are the software defaults and are the values
used by us during developmental validation. Laboratories must perform
appropriate internal validation studies to determine the appropriate values to
use.

5. Click Save.
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Create a HID size  The size standard for the AmpF{(STR® NGM SElect™ PCR Amplification Kit uses
standard the following GeneScan™ 600 LIZ™ Size Standard v2.0 peaks in its sizing algorithm:
60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 220, 240, 250, 260, 280, 300, 314,
320, 340, 360, 380, 400, 414, 420, 440 and 460.

Use the following procedure to create the size standard for the AmpF(STR® NGM
SElect™ Kit.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

f?_:l.‘.eneMapper Manager

|
|Name |Last Saved |Owner Type |Descripﬂon
377 _F_HD_G=500 2004-05-23 11:34:3 | gmid EasicifAdvanced Factory Provided -
CE_GS5_HID_GE=300 2004-05-28 11:34: 3 | gmid BasiciAdvanced Factory Provided
CE_F_HID_G=s00 2004-05-28 11:34: 3 | gyemicd Basicitdvanced Factory Provided —

Dane

M DRE... SEVE AT Inpart Export... Delete |

2. Select the Size Standards tab, then click New.
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3. Complete the Name field as shown below or with a name of your choosing. In
the Size Standard Dye field, select Orange. In the Size Standard Table, enter the
sizes specified in “Create a HID size standard” on page 58.

[®)5ize Standard Editor x|
Edit

—=ize Standard Description
Mame: CE_5_MNGMSElect GSEO0

Dezcription:

Size Standard Dye: IOrange LI

Size Standard Takle
Size in Bazepairs
1 0.0 | =

2 |&nno

Qo
o
>
()
<
D
e
ie]
o
S
<)
)
(72
o
=4
=
=
()

3 1000

4 1140

51200

6 1400

T 1600

g [1a0no

g9 |2000
10 |214.0 M

O | Cancel |
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Analyze and edit sample files with GeneMapper® ID
Software

Analyze a project 1. Inthe Project window, select File » Add Samples to Project, then locate the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above. If you use names of your
own choosing, select those names instead.

Parameter Settings
Sample Type Select the sample type
Analysis Method NGMSElect_AnalysisMethod_v1
Panel NGMSElect_panel_v1
Size Standard CE_G5_NGMSElect_GS600

» Size Standard: For more information about how the Size Caller works,
refer to the ABI Prism® GeneScan® Analysis Software for the Windows
NT® Operating System Overview of the Analysis Parameters and Size
Caller User Bulletin (PN 4335617).

* CE_G5_NGMSElect_GS600: 60, 80, 100, 114, 120, 140, 160, 180, 200,
214, 220, 240, 250, 260, 280, 300, 314, 320, 340, 360, 380, 400, 414, 420,
440 and 460 (size standard fragments defined in the AmpF(STR® NGM
SElect™ Kit). For additional information about size standards, refer to the
GeneMapper® ID Software Version 3.1 Human Identification Analysis
User Guide (PN 4338775), Appendix D.

3. Click ¥ (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

» The status bar displays the progress of analysis:

— As a completion bar extending to the right with the percentage
completed indicated

— With text messages on the left

+ The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample). The screenshot below is an
example. Some columns may have different names from the names shown.

* The Genotypes tab becomes available after analysis.
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For more information

[P GeneMapper ID ¥3.2.1 - NGM SElect Example - gmid Is Logged In
File  Edit

Analysis  Wiew Tools  Help
cf = ||% %HM{M J_|_[|| £l || - é ||TabIeSeﬂing:||IHlDTable LlE”-@ %Hﬂ.
E-EdProject Samples I Gehotypes |
D1 007128 _Bre Status | Sarnple FlSample Mame Sample Type | Analysis Method Panel Size Standard
1 h 1001 28_ | IB_07o1 Sample MGMSElect_Analysistlethad w1 MGMSElect_panel_v1 | CE_GS_NGMSElect_GSE00
2 I |100128_[B_0702 Sample MGMSElect_analysistethod_wl MGMSElect_panel_ vl |CE_GS_NGMSElect_GSEO0
3 h 100M128_|IB_0703 Sample MGMSElect_Analysistlethad w1 MGMSElect_panel_v1 | CE_GS_MNGMESElect_GSE00 CGD)
4 I |100125_[B_0704 Sample MGMSElect_analysistethod_wl MGMSElect_panel_ vl |CE_GS_NGMSElect_GSEO0 %
5 m 100126_|IB_0703 Sample MEMSElect_Analysistlethad w1 MEMSElect_panel_v1  |CE_G3_MNGMEIElect_GSE00 %
g I |100128_[B_0706 Sample MEMSElect_snalysishiethod_w1 NGMSElect_panel_vl  |CE_GS_NGMSElect_GSEO0 °
T Ik 100126_|IB_0707 Sample MGEMSElect_Analysistlethad w1 MGMSElect_panel_v1  |CE_G3_MGMEZElect_GSE00 )
g W |100128_[B_0708 Sample MEMSElect_snalysishiethod_v1 MGMSElect_panel_wl | CE_GS_MGMSElect_GSEO0 S
9 h 100126_|IB_0709 Sample MGEMSElect_Analysistlethad w1 MGMSElect_panel_v1  |CE_G3_MGMEZElect_GSE00 g’
10 s |100128_[B_0710 Sample MEMSElect_snalysishiethod_v1 MGMSElect_panel_vl  |CE_GS_MGMSElect_GSEO0 g"
11 I |100128_[B_0712 Tample MGMSElect_analysistethod_v MGMSElect_panel_vl  |CE_G5_NGMSElect_GSEO0 %
12 s  |100125_[B_O713 Sample MGMSElect_snalysishiethod vl |NGMSElect_panel_vl | CE_GS_NGMSElect_GSEO0
13 I |100125_[B_0714 Sample MGMSElect_analysistethod v MGMSElect_panel_vl  |CE_GS_NGMSElect_GSEO0
14 h 100128 | Ladder1 Allelic Ladder  |MNGMSElect_Analysistethod w1 MGMSElect_panel_v1 | CE_GS_NGMSElect_GSE00
)
[ 2
Progress Status ... I

Examine and edit
a project

the Project window (assuming the analysis is complete).

For more information

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of

For details about GeneMapper® ID Software features, allele filters, peak detection
algorithms, and project editing, refer to:

+ GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis

Tutorial (PN 4335523)

+ GeneMapper® ID Software Version 3.1 Human Identification Analysis User
Guide (PN 4338775)

« Installation Procedures and New Features for GeneMapper® ID Software
Version v3.2 User Bulletin (PN 4352543)
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Chapter 4

Section 4.2 GeneMapper® ID-X Software

Before you start

GeneMapper® ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis. After electrophoresis, the Data
Collection Software stores information for each sample in a .fsa file. Using
GeneMapper® ID-X Software v1.0.1 or higher, you can then analyze and interpret the
data from the .fsa files.

Note: Refer to “Instrument and software overview” on page 15 for a list of
compatible instruments.

When using GeneMapper® ID-X Software v1.0.1 or higher to perform human
identification (HID) analysis with AmpF{STR® kits, be aware that:

» HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided that you
conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a
run folder.

» Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

* Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

* Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

* Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder
(OL) alleles may contain full and/or partial repeat units. An off-ladder allele is
an allele that occurs outside the £0.5 nt bin window of any known allelic ladder
allele or virtual bin.
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Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory’s protocol.
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Workflow To analyze sample (.fsa) files using GeneMapper® ID-X Software v1.0.1 or higher
for the first time:

» Import panels, bins, and marker stutter into the Panel Manager, as explained in
“Import panels, bins, and marker stutter” on page 64.

* Create an analysis method, as explained in “Create an analysis method” on
page 70.

* Create a size standard, as explained in “Create a size standard” on page 77.

* Define custom views of analysis tables.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting
Started Guide (PN 4375574) for more information.

* Define custom views of plots.

Refer to Chapter 1 of the GeneMapper® ID-X Software Version 1.0 Getting
Started Guide (PN 4375574) for more information.

Import  To import the AmpF{STR® NGM SElect™ Kit panels, bin sets, and marker stutter
panels, bins, and  from our website into the GeneMapper® ID-X Software v1.0.1 or higher database:

marker stutter
1. Download and open the file containing panels, bins, and marker stutter:

a. From the Support menu of www.appliedbiosystems.com, select
Support » Software Downloads, Patches & Updates » GeneMapper®
ID-X Software » Updates & Patches, and download the file NGMSElect
Analysis Files GMIDX.

b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (PN 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

64 AmpF&TR® NGM SElect™ PCR Amplification Kit User Guide


http://www.appliedbiosystems.com
http://www.adobe.com
http://www.adobe.com
http://www.appliedbiosystems.com
http://www.appliedbiosystems.com
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« Panel Manager
File Edit EBins Miew Help

.Sl & B Bl BN
kit Mame Kit Type |Comment
1 mpFLaTR_FPanels_w1x  |Microsate null
2 |AmpFLSTR_MGM wix Microsate \null
3 |AmpFLSTR_MiGMSElect_+1|Microsate [null

b. In the toolbar, select File » Import Panels to open the Import Panels
dialog box.

Locate, then open the NGMSElect Analysis Files GMIDX folder that you
unzipped in step 1 on page 64.

e

d. Select NGMSElect_panel_v1X.txt, then click Import.

« Import Panels

Laok in: |D MGEMSElect Analysis Files GMIDY V| T EE

[E MGMSElect_bins_w1x.kxt

&/

B NGMSelack_panel_y £

My Recent (H] MGEMIEleck_stutker_wix.bxk
Documents

T
& h )/
fm]
=

My Docurments

<

My Compuker

&

File name: |NGMSe|ectJ:uanel_v1X.txt | [ Import ]

Iy Mebwork, _
Places Files of bype: |.q|| Files v | Caniel

Note: Importing this file creates a new folder in the navigation pane of the
Panel Manager “AmpFLSTR_NGMSElect_v1X”. This folder contains the
panel and associated markers.
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5. Import NGMSElect_bins_v1X:

pane.

a. Select the AmpFLSTR_NGMSElect_v1X folder in the left navigation

« Panel Manager.

File Edit Bins View Help

®
X | B MW | W™ | ensen] JIlicn N DEEEEE o
=8 &bpana Manager Panel Hame Comrament
(- [C2) AmpFLSTR_Panels_v1x 1

GMSElect_panel_w1x
- ICAMPFLSTR_NGM_v1¥

null

[#-[) AmpFLSTR_MGMSElect_v1x]

[ OF H Cancel H Apply H Help ]

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Locate, then open the NGMSElect Analysis Files GMIDX folder.
d. Select NGMSElect_bins_v1X, then click Import.

# Import Bin Set

Loak in: |D MEMSElect Analysis Files GMIDX

v 2 EE
L H NGMSElect_bins_w1x.bxt
i El mEMSelect_panel_w1X.kxk
My Recent (H] MGEMIEleck_stutker_wix.bxk
Documents
Deskkop
N
My Docurnents
My Compuker
-
8‘ File name: |NGMSEIect_bins_v1><.txt | [ Import ]
Iy Mebwork, _
Places Files of typet | all Files | Canicel

Note: Importing this file associates the bin set with the panels in the

NGMSElect_panel_v1X folder.
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6. View the imported panels in the navigation pane:

a. Double-click the AmpFLSTR_NGMSElect_v1X folder to view the
NGMSElect_panel_v1X folder.

b. Double-click the NGMSElect_panel_v1X folder to display the panel
information and the markers below it.

« Panel Manager

File Edit Bins View Help

SN B BE I N i WE R EEEEE
= lﬁ%bli‘anel Manager - Panel Hane Comment
---EJAmpFLSTR_PaneIs_VlX 1 GMSElect_panel_w1X il

- IC2) AMpFLSTR _MEM_v1x

[ER & ArpFLSTR_MEMSElect w1
= ICyMEMSElect_panel_v1i

- i

-D1ES539

-D251338

- AMEL

-D351179

-DZ1511

-D1&551

-DZ251045

-D195433

- THO1

-FGA

-D25441

-D351358

-D151656

-D125391 L |

- SE33

’ QF H Cancel ][ Apply ” Help ]
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c. Select D22S1045 to display the Bin view for the marker.

« Panel Manager.

File Edit Bins View Help
5 5 MM JE WY b Sets neect bins_yix v fLERE EEEEENE o
= 4By Panel Manager
-E)AmpFLSTR_PaneIs_le i a a 10 11 12 12 14 15 16 17 12 19
() AMPFLSTR_MNGM 13
=) [C3 AmpFLSTR_MGMSElect_vix
= [CINGMSElect_panel_v1x 03
0g
o7
0E
03
04
0z
0z
o1
on
hal T3 Th i T4 ¢ a3 a5 ar a8 a1 93 95 a7 93 101 103 103 107 108 1N M3 113 N7
D2251045
i AL
K 7722 Y. 037

[ OF J[ Cancel ][ Apply ][ Help ]
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7. Import NGMSElect_stutter_v1X:

a. Select the AmpFLSTR_NGMSElect_v1X folder in the navigation pane.
b. Select File » Import Marker Stutter to open the Import Marker Stutter
dialog box.
c. Locate, then open the NGMSElect Analysis Files GMIDX folder.
d. Select NGMSElect_stutter_v1X, then click Import.
Lok in: |b NGMSElect Analysis Files GMIDY v| T EE
oy [E mEMSElect_bins_ w13 kxt
L& El mEMselect_panel_w1x.bxt
My Recent =] MNGMSElect_stutte
Documents
€
Deskkop
My Docurments
[y .Computer
g' File name: | MEMSElect_skukber w1 Exk | [ Impork ]
Ty Metwark,
Flaces Files of type: |.q|| Files v| Caricel

Note: Importing this file associates the marker stutter ratio with the bin set
in the NGMSElect_bins_v1X folder.

8. View the imported marker stutters in the navigation pane:
a. Select the NGMSElect_panel_v1X folder to display its list of markers.

b. Double-click the NGMSElect_panel_v1X folder to display its list of
markers below it.
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X | FE@E W=

c. Double-click D22S1045 and select Stutter Ratio & Distance to display
the Stutter Ratio & Distance view for the marker.

Because D22S1045 has a trinucleotide repeat unit, it produces a higher
level of plus stutter than tetranucleotide markers, and so requires the use of
a plus stutter filter. The settings for the D22S1045 plus stutter filter can be
seen in the table in the right pane. Other markers may not require a plus
stutter filter, in which case the settings for plus stutter are left blank.

Bin Set: |NGMSEIect_bins_v1><

« Panel Manager

File Edit Bins Wiew Help

v ILERE EEEEENE @

(=) o5 Panel Manager

|23 AmpFLSTR_Panels_v1x

-2 AmpFLSTR_MGMSElect 1%
- CMGMSElect_panel_v1x

#- D1051248

i

- D165539

- D251338

..
.

- THO1

- FE@A

- DE5441
- 0351358
-D151656
- 0125391
- SE33

Flease enter the stutter filter(s) for D2251045 marker here If left blank, the global stutter filter will be applied.

Minus Stutter

Ratio

From Distance

To Distance

Plus Stutter

Ratio

1714

2,25

3.75

Fram Distance

To Distance

0B85

225

3.75

£ w| |~

W=

[ mew |[ Edt |[ pelet= |

[ OF H Cancel H Apply H Help ]

Create an

analysis method

9. Click Apply, then OK to add the AmpF(STR® NGM SElect™ Kit panels, bin
sets, and marker stutter to the GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter will not be imported into the GeneMapper®
ID-X Software database.

Use the following procedure to create an analysis method for the NGM SElect'™ kit.

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created for
GeneMapper® ID-X version 1.2 is not compatible with GeneMapper® ID-X Software
v1.1.1 or with GeneMapper® ID Software version 3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper® ID-X Manager.
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« GeneMapper® [D-X Manager

Find Mame Containing:
| Projects | Analysis Methads | Table Settings || Plat Settings || Matrices | Size Standards || Report Settings |
Marne Last Saved Cwner Inskrument analysis Type Description
| MEM_Anakysistethod_w1x 2009-08-30 23:49:2 |gmidx HID
[_ Mew, .. J [_ Open... ] [ Save As... ] [ Import... ] [_ Export... J

2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.

3. The figures below show the settings for each tab of the Analysis Method Editor.
Configure the Analysis Method Editor tab settings as shown in the figures
below, unless the instructions state otherwise.

Note: The Analysis Method Editor closes when you save your settings (See
step 4 on page 76). To complete this step quickly, do not save the analysis
method until you finish entering settings in all of the tabs.
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General tab settings

EJ

Analysis Method Editor

~Analysis Method Description

Tarne: | MGMSElect_analysisMethod_w1x |

Security Group: GeneMapper I ecurity Group

Description:

| S

Instrument:

Analysis Type: HID

[ Save H Cancel ][ Help ]

In the Name field, either type the name as shown for consistency with files
supplied with other AmpF(STR® kits or enter a name of your choosing. In the
Security Group field, select the Security Group appropriate to your software
configuration from the dropdown list. The Description and Instrument fields are
optional.
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Allele tab settings

Analysis Method Editor

| aeneral | Allele: | Peak Detector || Peak, Quality || SleR Y elal Settings|

=T S I G S E leck_bins w1
Use marker-specific stutter ratio and distance if available

Marker Repeat Type: Tri Tetra Penta Hexa

Global Cut-off Yalue 0.0 0.0 0.0 0.0

Minusé R.atio 0.0 0.0 0.0 0.0

Minusd, Distance Fram oo a.n a.n 0.0
To 0.0 0.0 0.0 0.0

Global Minus Skutker Rakio 0o 0.0 0.0 0.0

Global Minus Stutker Distance  From | 2,25 325 n.n 0.0
To 375 4,75 0.0 0.0

Global Plus Stutter Ratio 0.0 0.0 0.0 0.0

Global Plus Skukter Distance From | 0.0 0.0 0.0 0.0
To 0.0 0.0 0.0 0.0

Amelogenin Cukoff

F.ange Filter. .. Fackory Defaults

[ Save As ][ Save ][ Zancel ][ Help ]

* In the Bin Set field, select the NGMSElect_bins_v1X bin set imported
previously and configure the stutter distance parameters as shown.

 GeneMapper® ID-X Software v1.0.1 or higher allows you to specify 4
types of marker repeat motifs: tri, tetra, penta and hexa. You can enter
parameter values for each type of repeat in the appropriate column.

» The “Use marker-specific stutter ratio if applicable” check box is selected
by default. When this box is checked, the software applies the stutter ratio
filters in the NGMSElect_stutter_v1X file.
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Peak Detector tab settings

(%)

Analysis Method Editor

Peak, Detection Algorithm: advanced

ceneral | Allele |} Peak Detector | Peeak Quality | 50 & GO Settings

Ranges Peak Detection
Analysis Sizing Peak Amplitude Thresholds:
|Fu|| Range W |P.II Sizes “

B: | TBD | R:| TBD |
6:| TBD | 0:| TBD |

Y- TED
Smoothing and Baselining
R o Min. Peak Half Width: 2 pts
maothing Mane
® Light Palynomial Degree: 3
() Heavy Peak Window Size: 15 pts
EBaseline Window: pts Slape Threshold
Peak Stark: 0.0

rSize Calling Method
() 2nd Order Least Squares
() 3rd Order Least Squares
() Cubic Spling Interpolation
() Local Southern Method
() Global Southern Method

Peak End: 0.0

Factary Defaulks

l Save As ” Save ” Cancel ” Help l

IMPORTANT! TBD indicates values to be determined in your laboratory.
Laboratories must perform the appropriate internal studies to determine the
appropriate peak amplitude thresholds for interpretation of AmpF(STR® NGM
SElect™ Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to
specify the minimum peak height, in order to limit the number of detected
peaks. Although GeneMapper® ID-X Software displays peaks that fall
below the specified amplitude in electropherograms, the software does not
label or determine the genotype of these peaks.

+ Size calling method — The NGM SElect™ kit has been validated using the
Local Southern sizing method. Alternative sizing methods should be
selected only after extensive evaluation as part of an internal validation
study in the user’s laboratory.
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* Normalization — a Normalization checkbox is available on this tab in
GeneMapper® ID-X Software v1.2 for use in conjunction with data run on
the Applied Biosystems® 3500 Series Genetic Analyzers. Users of this
version of software should perform laboratory evaluations to determine
whether to use the Normalization feature for analysis of NGM SElect™ kit
data.

Peak Quality tab settings

Analysis Method Editor,

| General | allele || Peak Detector |{Peak Quality || sq & G Settings |

MinMax Peak Height (LPHIMPH)

-
==}
=}

-
=]
o

Haorozygous min peak height

Heterozygous min peak height

Max Peak Height (MPH) TBD
Peak Height Ratio (PHR)

i peak height ratio TBD
Broad Peak (ED)

—_
(4]

Max peak width (basepairs)

Allele Mumber (AR)

I

Max expected alleles

Allelic Ladder Spike

Zuk-off Yalue
[ Factory Defadls
[ Save ][ Cancel ][ Help ]

IMPORTANT! TBD indicates values to be determined in your laboratory.
Laboratories must perform the appropriate internal validation studies to
determine the minimum heterozygous and homozygous minimum peak height
thresholds, maximum peak height threshold and the minimum peak height ratio
threshold for reliable interpretation of AmpF(STR® NGM SElect™ Kit data.
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SQ & GQ tab settings

Analysis Method Editor, (%]

| General | Allele | Peak Detector || Peak Quality | 503 8GO Seftings |

Quality weights are between 0 and 1.
r3ample and Conkrol G0 Yeighting

Broad Peak (BD) 0.8 Allele Murnber (AN) 1.0
Out of Bin Allele (BIN) 0.8 Low Peak Height (LPH) 0.3
Cverlap (OWL) 0.5 Max Peak Height (MPH) 0.3
Marker Spike (SPK) 0.3 Off-scale (0S) 0.8

Peak Height Ratio (PHR) 0.3

Control Concordance (CC) Wieight = 1.0 {Only applicable to contraols)

S0 Weighting

Broad Peak {BDY

rallelic Ladder GO Weighting
Spike (S5PK/SPE) Off-scale (05)

~50 & G0 Ranges

Sizing Quality: From | 0.75 to 1.0 From0.0to | 025

Genotype Quality:  From | 0.75 to 1.0 From0.0to | 025

Reset Defaulks

T
o
b=l

[ Save hs H Save H Cancel ]

IMPORTANT! The values shown are the software defaults and are the values
used during developmental validation. Laboratories must perform appropriate
internal validation studies to determine the appropriate values to use.

4. Click Save.
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Create a size  The size standard for the AmpF(STR® NGM SElect™ PCR Amplification Kit uses
standard the following GeneScan™ 600 LIZ™ Size Standard v2.0 peaks in its sizing algorithm:
60, 80, 100, 114, 120, 160, 180, 200, 214, 220, 240, 250, 260, 280, 300, 314, 320,
340, 360, 380, 400, 414, 420, 440 and 460.

Use the following procedure to create the size standard for the NGM SElect™ kit.

1. Select Tools » GeneMapper® ID-X Manager to open the GeneMapper® ID-X
Manager.

2. Select the Size Standards tab, then click New.

# GeneMapper® ID-X Manager

Find Marme Containing:

| Projects | Analysis Methods | Table Settings | Flot Settings | Matrices | Size Standards _Report Settings |

Marme Last Saved owner Type Description
CE_F_HID_G5500 (75-400) 2007-05-09 13:23:5  gmid:x Advanced
CE_F_HID_ 35500 (75-450) 2007-05-09 13:24:0 gmid:x Advanced
CE_G5_HID Q5500 2006-10-11 13:12:2 gmid:x Advanced
CE_GS_MGM_i35500 2010-02-03 13:45:¢ | gmid:x Advanced
G3400HD 2010-06-23 0957 |amidx Advanced

Mew, .. cpen.. Save As.., Export.,.
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3. Complete the Name field as shown below or with a name of your choosing. In
the Security Group field, select the Security Group appropriate to your software
configuration from the dropdown list. In the Size Standard Dye field, select
Orange. In the Size Standard Table, enter the sizes specified in “Create a size

standard” on page 77.
« Size Standard Editor 3]
Edit
r3ize Standard Descripkion
Marne: CE_GS_MGMSElect_GSE00w2
Securiby Group: GeneMapper ID-1 Security Group %
Descripkion:
Size Standard Dye: |Orange w |
raize Skandard Table
Size in Basepairs — [ Tneert ] [ Delete ]

Zz (80,0 -

3 (100.0

4 [114.0

5 [120.0

6 (140.0

7 [1e0.0

& [180.0

9 [200.0 =

10 [214.0

11 [220.0

1z [240.0

13 [250.0

14 [260.0

15 [250.0

16 [300.0 d

[ [al'd ] [ Zancel ] [ Help ]
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Analyze and edit sample files with GeneMapper® ID-X

Software

Analyze a project 1. Inthe Project window, select File » Add Samples to Project, then go to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above. If you use names of your
own choosing, select those names.

Parameter Settings
Sample Type Select the sample type
Analysis Method NGMSElect_AnalysisMethod_v1X
Panel NGMSElect_panel_viX
Size Standard CE_G5_NGMSElect_GS600v2

» Size Standard: For more information about how the Size Caller works,
refer to the ABI PRISM® GeneScan® Analysis Software for the Windows
NT® Operating System Overview of the Analysis Parameters and Size
Caller User Bulletin (PN 4335617).

* CE_G5_NGMSElect_GS600v2 (size standard fragments defined in the
NGM SElect™ kit): 60, 80, 100, 114, 120, 160, 180, 200, 214, 220, 240,
250, 260, 280, 300, 314, 320, 340, 360, 380, 400, 414, 420, 440 and 460.
For additional information about size standards, refer to the GeneMapper®
1D Software Version 3.1 Human Identification Analysis User Guide (PN
4338775), Appendix D.

3. Click # (Analyze), enter a name for the project (in the Save Project dialog
box), then click OK to start analysis.

* The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage completed indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Analysis Summary tab is displayed upon completion of the analysis.

©
(0]
=}
[©)
<
Q
o
O
(0]
=
@
S
x
(9]
o,
—
3
Q
=3
o

AmpF&TR® NGM SElect™ PCR Amplification Kit User Guide 79



Section 4.2

Analysis summary window after analysis

« GeneMapper® ID-X - NGMSElect Example - gmidx Is Logged In Database GBOLDROYNJO9E

File Edit Analysis Yiew Tools Admin  Help
i [~ ] % F =Rl e @  TableSetting: |31 Data Analysis v | BH P&l ||
&~ ﬂ%ﬁpmje“ N Samples | Analysis Summary | Genobypes
ol | |
Analysis Summary
Select run Folder ko display: | |
Sample Status || Total # of Samples |
U Unanalyzed i
Analyzed 33
U Analysis Setting Changed 0
Click a link below to display a filtered Samples Tahle containing only the samples selected.
Allelic Ladder Quality per run folder {hased on SQ and CGQ only)
[ Run Falder ][ Tokal # of Analyzed Ladders ] & E
MGM SElect Example | 3 | 3 | o | o |
Control Quality per project (based on sample PQVs: S0S, SSPK, MIX, OMR, S0, CGQ)
[ Contral Type ][ Tatal # of Samples ] all threshalds met ][ . Cne o mare thres!
Positive Conkrol 1 1 1]
Custom Control 1} 0 1}
Megative Control 3 3 1]
Tokal 4 4 a
Sample Quality per project (hased on sample POVYs: S0S, SSPK, MIX, OMR, S0, CGQ)
[ ][ Total # of Samples ] All thresholds met ][ O One ar more thresl
Samples | 26 | a | 23
< |
Analysis Complated.

Examine and edit You can display electropherogram plots from the Samples and Genotypes tabs of the
a project Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).
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For more information

+ For quick set-up instructions, refer to the GeneMapper® ID-X Software Version
1.0 Getting Started Guide (PN 4375574).

+  For details about GeneMapper® ID-X Software features, allele filters, peak
detection algorithms, and project editing, refer to:

— GeneMapper® ID-X Software Version 1.0 Getting Started Guide
(PN 4375574)

—  GeneMapper® ID-X Software Version 1.0 Quick Reference Guide
(PN 4375670)

— GeneMapper® ID-X Software Version 1.0 Reference Guide (PN 4375671)

—  GeneMapper® ID-X Software Version 1.1 (Mixture Analysis Tool) Getting
Started Guide (PN 4396773)

— GeneMapper® ID-X Software 1.1 (Mixture Analysis Tool) Quick Reference
Guide (PN 4402094)
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Chapter 5 Experiments and Results

Overview

Experiments
using the

AmpF(STR® NGM

SElect™ Kit

Importance of
validation

Experiment
conditions

This chapter provides results of the developmental validation experiments performed
using the AmpF(STR® NGM SElect™ PCR Amplification Kit.

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics.
By challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations that
are critical for sound data interpretation in casework (Sparkes, Kimpton, Watson et
al., 1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin et al., 1998).

Experiments to evaluate the performance of the AmpF/(STR® NGM SElect™ PCR
Amplification Kit were performed. The experiments were performed according to
the revised guidelines from the Scientific Working Group on DNA Analysis Methods
(SWGDAM, July 10, 2003). Based on these guidelines, we conducted experiments
that comply with guidelines 1.0 and 2.0 and its associated subsections. This DNA
methodology is not novel. (Moretti et al., 2001; Frank et al., 2001; Wallin et al.,
2002; and Holt et al., 2000).

This chapter discusses many of the experiments performed and provides examples of
results obtained. We chose conditions that produced optimum PCR product yield and
that met reproducible performance standards. It is our opinion that while these
experiments are not exhaustive, they are appropriate for a manufacturer of STR kits
intended for forensic and/or parentage testing use.

IMPORTANT! Each laboratory using the AmpF{STR® NGM SElect™ PCR
Amplification Kit must perform internal validation studies.
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Developmental validation

SWGDAM
guideline 1.2.1

SWGDAM
guideline 2.10.1

PCR components

“Developmental validation is the demonstration of the accuracy, precision, and
reproducibility of a procedure by the manufacturer, technical organization, academic
institution, government laboratory, or other party.” (SWGDAM, July 2003)

“The reaction conditions needed to provide the required degree of specificity and
robustness must be determined. These include thermocycling parameters, the
concentration of primers, magnesium chloride, DNA polymerase, and other critical
reagents.” (SWGDAM, July 2003)

We examined the concentration of each component of the AmpF/STR® NGM
SElect™ Kit and established that the concentration of each component was within the
range where data indicated that the amplification met the required performance
criteria for specificity, sensitivity, and reproducibility. For example, 1ng of Control
DNA 007 was amplified in the presence of varying concentrations of magnesium
chloride, and the results were analyzed on an Applied Biosystems® 3130x/ Genetic
Analyzer. Results are shown in Figure 2. The performance of the multiplex is most
robust within £20% of the optimal magnesium chloride concentration.
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Thermal cycler
parameters

Figure 2 1.0 ng of control DNA 007 amplified with the AmpF(STR® NGM SElect™
Kit in the presence of varying concentrations of magnesium chloride and
analyzed on an Applied Biosystems® 3130x/ Genetic Analyzer.

Thermal cycling parameters were optimized using a Design of Experiments (DOE)
approach that attempts to identify the combination of temperatures and hold times
that produce the best assay performance. Optimal assay performance was determined
through evaluation of assay sensitivity, peak-height balance and resistance to PCR
inhibitors.

For example, annealing temperatures of 55, 57, 59, 61, and 63 °C were tested using a
Silver 96-Well GeneAmp® PCR System 9700 (Figure 3). The PCR products were
analyzed using an Applied Biosystems® 3130x/ Genetic Analyzer.

Of the tested annealing temperatures, 55 to 61 °C produced robust profiles. At 63 °C
the yield of the majority of loci was significantly reduced. The optimal combination
of specificity, sensitivity, and resistance to PCR inhibition was observed at 59 °C.
Thermal cycler temperature is critical to assay performance; therefore, routine,
regularly scheduled thermal cycler calibration is strongly recommended.
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Figure 3 Electropherograms obtained from amplification of 1.0 ng of control
DNA 007 at annealing temperatures of 55 °C, 57 °C, 59 °C, 61 °C, and 63 °C,
analyzed on an Applied Biosystems® 3130x/ Genetic Analyzer, (Y-axis scale 0 to
3,000 RFU).

PCR cycle AmpF(STR® NGM SElect™ Kit reactions were amplified for 27, 28, 29, 30, and 31
number cycles on the Silver 96-Well GeneAmp® PCR System 9700 using 1.0 ng of each of
three DNA samples. As expected, the amount of PCR product increased with the
number of cycles. A full profile was generated for all numbers of thermal cycles
(27-31) and oft-scale data were collected for several allele peaks at 30 and 31 cycles

(Figure 4).

Optimal sensitivity was produced by 29 cycles when the amplified products were
analyzed on Applied Biosystems® 3130x/ Genetic Analyzers. None of the cycle
numbers tested produced nonspecific peaks.
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Figure 4 Representative AmpF/STR® NGM SElect™ Kit profiles obtained from
amplification of 1.0 ng DNA template using 27, 28, 29, 30, and 31 cycles,
analyzed on an Applied Biosystems® 3130x/ Genetic Analyzer, (Y-axis scale 0 to
8,000 RFU)
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Accuracy, precision, and reproducibility

SWGDAM

guideline 2.9

0.50 -

0.25 -

Size Difference (nt)
o
o

-0.25 -

-0.50 -

Accuracy

“The extent to which a given set of measurements of the same sample agree with
their mean and the extent to which these measurements match the actual values being
measured should be determined.” (SWGDAM, July 2003)

Laser-induced fluorescence detection of length polymorphism at short tandem repeat
loci is not a novel methodology (Holt et al., 2000; and Wallin et al., 2002). However,
accuracy and reproducibility of AmpF(STR® NGM SElect™ Kit profiles have been
determined from various sample types. Figure 5 shows the size differences that are
typically observed between sample alleles and allelic ladder alleles on the Applied
Biosystems® 3130x/ Genetic Analyzer with POP-4™ polymer. The X axis in Figure 5
represents the nominal nucleotide sizes for the AmpF/STR® NGM SElect™ Allelic
Ladder. The dashed lines parallel to the X axis represent the £0.25-nt windows. The
Y axis represents the deviation of each sample allele size from the corresponding
Allelic Ladder allele size. All sample alleles are within +0.5 nt from a corresponding
allele in the Allelic Ladder.

D1S1656
D2s441
0251338
0351358
Das1179
01051248
0125391
0  DI16S539
D18851
D195433
D211
02251045
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Allele Size (nt)

Figure 5 Allele Size vs. Allelic Ladder Sizing for 42 samples analyzed on an
Applied Biosystems® 3130x/ Genetic Analyzer. Size and ladder sizing for the
AmpF(STR® NGM SElect™ Kit were calculated using the GeneScan™ 600 LIZ™
v2.0 Size Standard.
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Precision and
size windows

Sizing precision enables the determination of accurate and reliable genotypes. Sizing
precision was measured on an Applied Biosystems® 3130x/ Genetic Analyzer. The
recommended method for genotyping is to employ a +0.5-nt “window” around the
size obtained for each allele in the AmpF(STR® NGM SElect ™ Allelic Ladder. A
+0.5-nt window allows for the detection and correct assignment of alleles. Any
sample allele that sizes outside the specified window could be:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the
AmpF(STR® NGM SElect™ Allelic Ladder

or

* An allele that does correspond to an Allelic Ladder allele, but whose size is just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree
of precision in sizing an allele multiple times. Precision is measured by calculating
the standard deviation in the size values obtained for an allele that is run in several
injections on a capillary instrument.

Table 4 on page 95 shows typical precision results obtained from five runs

(16 capillaries/run) of the AmpF(STR® NGM SElect™ Allelic Ladder on an Applied
Biosystems® 3130x/ Genetic Analyzer (36-cm capillary and POP-4™ polymer), using
the GeneScan'" 600 LIZ™ v2.0 Size Standard. The results were obtained within a set
of injections on a single capillary array.

Sample alleles may occasionally size outside of the +0.5-nt window for a respective
Allelic Ladder allele because of measurement error. The frequency of such an
occurrence is lowest in detection systems having the smallest standard deviations in
sizing. Figure 5 on page 93 illustrates the tight clustering of allele sizes obtained on
the Applied Biosystems® 3130x/ Genetic Analyzer, where the standard deviation in
sizing is typically less than 0.15 nt. The instance of a sample allele sizing outside the
+0.5-nt window because of measurement error is relatively rare when the standard
deviation in sizing is approximately 0.15 nt or less (Smith, 1995).

For sample alleles that do not size within a +0.5-nt window, the PCR product must be
rerun to distinguish between a true off-ladder allele versus measurement error of a
sample allele that corresponds with an allele in the Allelic Ladder. Repeat analysis,
when necessary, provides an added level of confidence in the final allele assignment.

GeneMapper® ID Software and GeneMapper® ID-X Software automatically flag
sample alleles that do not size within the prescribed window around an allelic ladder
allele by labelling the allele as OL (off-ladder).

Maximum sizing precision is obtained within the same set of capillary injections.
Cross-platform sizing differences occur due to a number of factors including type
and concentration of polymer, run temperature, and electrophoresis conditions.
Variations in sizing can also occur between runs on the same instrument and between
runs on different instruments of the same platform type because of these factors.
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We strongly recommend that the allele sizes be compared to the sizes obtained for

known alleles in the AmpF(STR® NGM SElect™ Allelic Ladder from the same run

and then be converted to genotypes as described in “Before you start” on pages 47

(GeneMapper® ID Software) and 63 (GeneMapper® ID-X Software). See Table 4 for

the results of five runs of the AmpF(STR® NGM SElect™ Allelic Ladder on an

Applied Biosystems® 3130x/ Genetic Analyzer. For more information on precision
and genotyping, see Lazaruk et al., 1998 and Mansfield et al., 1998.

In Table 4, the mean sizes for all the alleles in each run (16 capillaries) were
calculated. The mean range shown in the table represents the lowest and highest

mean size values obtained across all five runs. Similarly, the standard deviation for
the allele sizing was calculated for all the alleles in each run. The standard deviation
range shown in Table 4 represents the lowest and highest standard deviation values
obtained across all five runs.

Table 4 Precision results of five runs (16 capillaries/run) of the AmpF(STR® NGM

SElect™ Allelic Ladder

Allele Mean Standard Deviation
AMEL
X 98.96-98.98 0.024-0.038
Y 104.99-105.02 0.027-0.039
D10S1248
8 74.74-74.83 0.030-0.044
9 78.97-79.06 0.026-0.043
10 83.17-83.26 0.028-0.044
11 87.34-87.45 0.031-0.053
12 91.49-91.60 0.028-0.042
13 95.64-95.76 0.037-0.045
14 99.76-99.86 0.024-0.043
15 103.93-104.05 0.032-0.052
16 108.06-108.18 0.028-0.044
17 112.14-112.26 0.033-0.054
18 116.14-116.25 0.026-0.046
D12S391
14 228.77-228.81 0.034-0.051
15 232.73-232.75 0.036-0.049
16 236.74-236.76 0.033-0.044
17 240.68-240.71 0.035-0.041
18 244.72-244.76 0.031-0.045
19 248.71-248.75 0.037-0.046
19.3 251.71-251.75 0.038-0.041
20 252.66-252.70 0.035-0.047
21 256.51-256.54 0.025-0.039
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Allele Mean Standard Deviation
22 260.26-260.31 0.036-0.044
23 264.22-264.27 0.034-0.043
24 268.24-268.30 0.034-0.045
25 272.22-272.27 0.030-0.047
26 276.16-276.21 0.031-0.049
27 280.22-280.26 0.022-0.040

D16S539
5 227.39-227.51 0.050-0.060
8 239.52-239.63 0.040-0.055
9 243.66-243.78 0.040-0.051
10 247.78-247.89 0.042-0.055
11 251.82-251.92 0.037-0.055
12 255.79-255.89 0.045-0.049
13 259.73-259.83 0.040-0.049
14 263.74-263.85 0.035-0.059
15 267.76-267.89 0.034-0.049
D18S51

7 261.17-261.26 0.027-0.051
9 269.29-269.40 0.036-0.051
10 273.36-273.48 0.032-0.054
10.2 275.38-275.46 0.028-0.049
11 277.44-277.53 0.037-0.043
12 281.46-281.57 0.030-0.043
13 285.48-285.59 0.031-0.050
13.2 287.45-287.57 0.031-0.046
14 289.52-289.62 0.034-0.038
14.2 291.48-291.59 0.033-0.051
15 293.53-293.62 0.032-0.050
16 297.53-297.63 0.031-0.051
17 301.51-301.60 0.028-0.047
18 305.47-305.55 0.031-0.041
19 309.49-309.56 0.034-0.050
20 313.55-313.62 0.033-0.042
21 317.81-317.89 0.031-0.038
22 322.07-322.18 0.033-0.051
23 326.12-326.21 0.037-0.050
24 330.22-330.30 0.039-0.047
25 334.30-334.38 0.029-0.045
26 338.33-338.40 0.033-0.049
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Allele Mean Standard Deviation
27 342.41-342.48 0.028-0.042
D19S433
9 125.98-126.02 0.033-0.040
10 129.78-129.82 0.031-0.038
11 133.60-133.65 0.027-0.044
12 137.45-137.50 0.026-0.038
12.2 139.41-139.47 0.024-0.043
13 141.35-141.38 0.032-0.037
13.2 143.34-143.38 0.031-0.040
14 145.29-145.32 0.029-0.038
14.2 147.27-147.31 0.023-0.039
15 149.22-149.25 0.030-0.040
15.2 151.21-151.26 0.026-0.043
16 153.18-153.22 0.027-0.035
16.2 155.16-155.21 0.027-0.037
17 157.12-157.18 0.031-0.042
17.2 159.12-159.18 0.024-0.036
D1S1656
9 173.48-173.54 0.027-0.047
10 177.41-177.48 0.033-0.048
11 181.37-181.43 0.031-0.044
12 185.36-185.41 0.027-0.036
13 189.38-189.43 0.024-0.042
14 193.45-193.49 0.024-0.036
14.3 196.44-196.50 0.030-0.047
15 197.33-197.36 0.026-0.042
15.3 200.40-200.46 0.024-0.043
16 201.25-201.30 0.022-0.045
16.3 204.31-204.37 0.030-0.039
17 205.16-205.21 0.027-0.041
17.3 208.21-208.28 0.025-0.044
18.3 212.13-212.20 0.030-0.034
19.3 216.11-216.16 0.029-0.039
20.3 220.12-220.16 0.030-0.042
D21S11
24 182.86-182.97 0.030-0.054
24.2 184.92-185.04 0.032-0.055
25 186.95-187.07 0.026-0.051
26 191.05-191.17 0.031-0.051
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Allele Mean Standard Deviation
27 195.18-195.28 0.030-0.044
28 199.22-199.34 0.032-0.047

28.2 201.20-201.30 0.035-0.037
29 203.17-203.29 0.024-0.043
29.2 205.23-205.33 0.032-0.046
30 207.19-207.29 0.033-0.040
30.2 209.18-209.28 0.032-0.046
31 211.18-211.29 0.031-0.045
31.2 213.17-213.29 0.033-0.047
32 215.21-215.32 0.031-0.048
32.2 217.24-217.36 0.035-0.048
33 219.31-219.44 0.036-0.055
33.2 221.27-221.41 0.039-0.050
34 223.41-223.55 0.043-0.053
34.2 225.34-225.47 0.035-0.050
35 227.42-227.55 0.035-0.052
35.2 229.37-229.51 0.039-0.053
36 231.38-231.51 0.033-0.049
37 235.46-235.61 0.038-0.058
38 239.44-239.56 0.032-0.055

D22S1045
5 78.18-78.21 0.031-0.043
6 81.29-81.32 0.032-0.040
7 84.36-84.39 0.031-0.047
8 87.45-87.48 0.027-0.043
9 90.52-90.56 0.028-0.042
10 93.59-93.63 0.021-0.038
11 96.66-96.70 0.028-0.036
12 99.74-99.77 0.022-0.038
13 102.83-102.87 0.025-0.039
14 105.91-105.97 0.024-0.045
15 108.98-109.04 0.030-0.046
16 112.04-112.09 0.034-0.041
D2S1338

15 288.31-288.45 0.034-0.051
16 292.31-292.45 0.042-0.056
17 296.27-296.42 0.041-0.045
18 300.19-300.32 0.036-0.050
19 304.11-304.25 0.035-0.059
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Allele Mean Standard Deviation
20 308.06-308.20 0.045-0.051
21 312.06-312.20 0.034-0.051
22 316.20-316.34 0.038-0.054
23 320.41-320.54 0.027-0.056
24 324.52-324.64 0.040-0.050
25 328.58-328.71 0.036-0.049
26 332.62-332.74 0.037-0.053
27 336.67-336.77 0.035-0.054
28 340.93-341.03 0.033-0.049

D2S441
9 78.49-78.50 0.030-0.037
10 82.63-82.66 0.027-0.037
11 86.76-86.79 0.023-0.038
12 89.94-89.97 0.024-0.039
13 90.87-90.88 0.025-0.044
14 94.82-94.84 0.027-0.036
15 98.92-98.94 0.025-0.034
16 103.05-103.08 0.026-0.038

D3S1358
12 133.60-133.70 0.026-0.039
13 137.62-137.71 0.027-0.050
14 141.52-141.62 0.031-0.048
15 145.40-145.49 0.025-0.050
16 149.51-149.61 0.030-0.041
17 153.62-153.72 0.027-0.040
18 157.61-157.71 0.036-0.044
19 161.51-161.61 0.031-0.053

D8S1179
8 122.53-122.56 0.033-0.040
9 126.53-126.56 0.027-0.039
10 130.55-130.57 0.028-0.042
11 134.60-134.63 0.023-0.037
12 138.67-138.71 0.026-0.040
13 142.90-142.92 0.023-0.041
14 147.03-147.06 0.027-0.036
15 151.18-151.20 0.028-0.040
16 155.33-155.37 0.023-0.040
17 159.49-159.52 0.008-0.040
18 163.59-163.62 0.024-0.039
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Allele Mean Standard Deviation
19 167.67-167.70 0.027-0.038
FGA
17 232.00-232.06 0.026-0.047
18 235.84-235.90 0.030-0.047
19 239.67-239.72 0.036-0.047
20 243.58-243.64 0.032-0.045
21 247.49-247.55 0.036-0.049
22 251.34-251.40 0.023-0.053
23 255.12-255.17 0.030-0.047
24 258.85-258.92 0.034-0.047
25 262.64-262.73 0.036-0.050
26 266.48-266.58 0.034-0.057
26.2 268.35-268.46 0.029-0.051
27 270.39-270.50 0.036-0.057
28 274.24-274.35 0.034-0.053
29 278.05-278.17 0.031-0.048
30 281.80-281.92 0.032-0.051
30.2 284.05-284.19 0.033-0.046
31.2 287.85-287.98 0.035-0.047
32.2 291.64-291.77 0.035-0.046
33.2 295.44-295.57 0.034-0.053
42.2 330.53-330.68 0.040-0.055
43.2 334.39-334.54 0.037-0.055
44.2 338.38-338.53 0.041-0.061
45.2 342.30-342.45 0.044-0.067
46.2 345.90-346.07 0.045-0.057
47.2 349.74-349.92 0.046-0.073
48.2 353.77-353.93 0.046-0.063
50.2 361.42-361.59 0.053-0.074
51.2 365.26-365.44 0.037-0.070
SE33

4.2 311.01-311.05 0.030-0.039
6.3 320.41-320.46 0.031-0.062
8 325.55-325.58 0.031-0.061
9 329.62-329.66 0.035-0.057
11 337.65-337.71 0.034-0.047
12 341.73-341.79 0.039-0.054
13 345.82-345.87 0.038-0.046
14 349.89-349.93 0.028-0.050
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Allele

Mean

Standard Deviation

15
16
17

353.93-353.96
358.04-358.09
362.12-362.18

0.032-0.041
0.032-0.057
0.029-0.055

18
19
20
20.2
21
21.2
22.2
23.2
24.2
25.2
26.2
27.2
28.2
20.2
30.2
31.2
32.2
33.2
34.2
35
35.2
36
37
THO1

366.17-366.23
370.10-370.16
374.14-374.20
376.13-376.18
378.13-378.19
380.11-380.18
384.19-384.25
388.29-388.34
392.33-392.38
396.31-396.36
400.39-400.44
404.38-404.41
408.32-408.37
412.30-412.35
416.38-416.44
420.40-420.45
424.52-424.59
428.55-428.60
432.53-432.58
434.53-434.61
436.53-436.62
438.56-438.61
442.58-442.65

179.32-179.35
183.33-183.39
187.37-187.42
191.40-191.45
195.42-195.46
199.45-199.49
202.45-202.49
203.36-203.41
207.31-207.34
218.29-218.33

0.031-0.048
0.032-0.049
0.021-0.041
0.026-0.047
0.025-0.043
0.024-0.043
0.035-0.048
0.027-0.043
0.031-0.045
0.032-0.050
0.029-0.048
0.028-0.056
0.033-0.061
0.035-0.050
0.033-0.040
0.020-0.048
0.035-0.057
0.032-0.053
0.030-0.047
0.029-0.050
0.032-0.055
0.027-0.052
0.039-0.059

0.032-0.050
0.024-0.041
0.034-0.050
0.029-0.042
0.031-0.043
0.031-0.052
0.030-0.043
0.028-0.045
0.021-0.043
0.027-0.049

151.26-151.34

0.031-0.042
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Allele Mean Standard Deviation
12 155.35-155.44 0.026-0.040
13 159.51-159.57 0.034-0.037
14 163.78-163.84 0.028-0.042
15 167.71-167.77 0.031-0.043
16 171.76-171.84 0.033-0.049
17 175.80-175.89 0.028-0.039
18 179.79-179.87 0.027-0.051
19 183.90-184.00 0.025-0.050
20 187.99-188.08 0.031-0.050
21 192.05-192.13 0.031-0.048
22 196.11-196.19 0.035-0.049
23 200.08-200.15 0.027-0.041
24 204.40-204.47 0.030-0.043

Extra peaks in the electropherogram

Causes of extra

peaks

Peaks other than the target alleles may be detected on the electropherogram. Causes
for the appearance of extra peaks include stutter products, incomplete 3” A
nucleotide addition (at the n-1 position), dye artifacts, and mixed DNA samples (see
DAB Standard 8.1.2.2).

Stutter products

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller (or less frequently, one repeat larger) than the major
STR product (Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter
products at tetranucleotide STR loci has revealed that the stutter product is missing a
single tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996).

The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Peak heights were measured for amplified samples (N = 1,080) at the loci used
in the AmpF(STR® NGM SElect™ Kit. All data were generated on the Applied
Biosystems® 3500xL Genetic Analyzer.

Some conclusions from these measurements and observations are:

* For each AmpF(STR® NGM SElect™ Kit locus, the percent stutter generally
increases with allele length, as shown in Figures 6 to 11 on pages 103 to 106.

* Smaller alleles display a lower level of stutter relative to the longer alleles
within each locus.

» Each allele within a locus displays a percent stutter that is consistent.
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+ Stutter filter sets in GeneMapper® ID and GeneMapper® ID-X Software,
calculated as the mean stutter for the locus plus three standard deviations
(N =1,080), are shown in Table 5 on page 107. Peaks in the stutter position that
are above the stutter filter percentage specified in the software are not filtered.
Peaks in the stutter position that have not been filtered and remain labeled can
be further evaluated. For evaluation of mixed samples, see Figure 22 on
page 126.

* The measurement of percent stutter for allele peaks that are off-scale may be
unusually high due to artificial truncation of the main allele peak.
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Figure 6 Stutter percentages for D10S1248, D12S391 and D16S539 loci. (Blue
and red colors indicate loci labeled with FAM™ and PET® dyes, respectively.)
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Figure 7 Stutter percentages for the D18S51, D19S433 and D1S1656 loci.
(Green, black and red colors indicate loci labeled with VIC®, NED™ and PET®
dyes, respectively.)
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Figure 8 Stutter percentages for the D21S11, D22S1045 and D2S1338 loci.
(Green, black/gray, and blue colors indicate loci labeled with VIC®, NED™ and
FAM™ dyes, respectively. Black and gray data points associated with the
D22S1045 locus indicate minus and plus stutter, respectively.)
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Figure 9 Stutter percentages for the FGA and THO1 loci. (Black data points
indicate loci labeled with NED™ dye.)
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Table 5 Marker-specific stutter filter percentages for AmpF(STR® NGM SElect™

Kit loci
Locus¥ % Stutter
D10S1248 12.04
D12S391 14.77
D16S539 9.87
D18S51 13.81
D19S433 11.02
D1S1656 13.60
D1S1656 (- 2 nt)$ 7.51
D21S11 10.43
D22S1045 17.14
D22S1045 (+3 nt) 6.65
D2S1338 12.32
D2S441 9.03
D3S1358 11.91
D8S1179 9.93
FGA 11.52
SE33 15.12
SE33 (- 2 nt)$ 5.95
THO1 4.93
vWA 11.18

1 These percentages are used as stutter filters in GeneMapper® ID v3.2.1 NGMSElect_panel_v1 and
GeneMapper® ID-X NGMSElect_stutter_viX.

§ The - 2nt stutter filters are not included in GeneMapper® /D NGMSElect_panel v1 due to functional
limitations of the software.

IMPORTANT! The values shown are the values determined during developmental
validation studies. We recommend that laboratories perform internal validation
studies to determine the appropriate values to use.

Addition of 3" A nucleotide

Many DNA polymerases can catalyze the addition of a single nucleotide
(predominantly adenosine) to the 3" ends of double-stranded PCR products (Clark,
1988; Magnuson et al., 1996). This nontemplate addition results in a PCR product
that is one nucleotide longer than the actual target sequence. The PCR product with
the extra nucleotide is referred to as the “+A” form.

The efficiency of +A addition is related to the particular sequence of the DNA at the
3" end of the PCR product. The AmpF{(STR® NGM SElect™ Kit includes two main
design features that promote maximum +A addition:

» The primer sequences have been optimized to encourage +A addition.
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* The new, highly robust PCR chemistry allows complete +A addition with a
short final incubation at 60 °C for 10 minutes.

This final extension step gives the DNA polymerase additional time to complete +A
addition to all double-stranded PCR products. See Figure 12 on page 108 for
examples of incomplete and normal +A addition. Final extension incubation for
longer than the recommended 10 minutes may result in double +A addition, in which
two non-template adenosine residues are added to the PCR product. Double +A
addition can cause “shoulders” on the right side of main allele peaks, and is therefore
to be avoided.
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Figure 12 Omitting the final extension step results in shoulders on main allele
peaks due to incomplete A nucleotide addition. Data are from an Applied
Biosystems® 3130x/ Genetic Analyzer using the AmpF(STR® NGM SElect™ Kit.

Due to improved PCR buffer chemistry, the lack of +A addition is generally less of
an issue with the AmpF/STR® NGM SElect'™ Kit than with earlier generation kits.
However, “shouldering” of allele peaks may still be observed if the amount of input
DNA is greater than that recommended by the NGM SElect™ kit protocol.
Amplification of excess input DNA may also result in offscale data.
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Artifacts Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible while anomalies are non-reproducible, intermittent
occurrences that are not observed consistently in a system (for example, spikes and
baseline noise). Due to improvements in PCR primer manufacturing processes, the
incidence of artifacts has been greatly reduced in the AmpF(STR® NGM SElect™
Kit. Kit electropherograms are essentially free of reproducible dye artifacts within
the kit's read region of 68 — 45 nt. Figure 13 on page 110 shows the very low baseline
level fluorescence of a typical negative control PCR using the AmpF{STR® NGM
SElect™ Kit.

Most STR loci produce minus-stutter peaks as a byproduct of PCR amplification. A
process of “slippage” has been proposed as a molecular mechanism for stutter, where
the Taq DNA polymerase enzyme “slips” on the template DNA during replication
and produces a minority PCR product that is shorter than the template strand, usually
by one repeat unit. The stutter process may also occur in the opposite direction to
produce amplicon DNA that is usually one repeat unit longer than the template
strand, termed plus-stutter. While plus-stutter is normally much less significant than
minus-stutter in STR loci with tetranucleotide repeats, the incidence of plus-stutter
may be more significant in trinucleotide repeat-containing loci. The D22S1045 locus
in the NGM SElect ™ kit is a trinucleotide repeat locus, and shows an elevated level of
plus-stutter. For example, Figure 15 on page 112 is an electropherogram of the
D22S1045 locus showing plus stutter. GeneMapper® ID and GeneMapper® ID-X
analysis files supplied for use with the NGM SElect™ kit contain a plus-stutter filter
to prevent these peaks from being called in normal profiles.

Figure 14 on page 111 shows an example of a non-standard (minus 2-nt) stutter that
may be observed in certain STR loci such as SE33 and D1S1656 that include more
complex nucleotide sequences including regions of dinucleotide repeats. In cases
where these stutter peaks exceed the peak amplitude threshold (e.g., 50 RFU), they
may be detected by analysis software as additional alleles in the profile.

It is important to consider possible noise and artifacts when interpreting data from
the AmpF(STR® NGM SElect™ Kit on the Applied Biosystems® 3500/3500xL,
Applied Biosystems® 3130/3130x/, and ABI PRISM® 3100/3100-Avant Genetic
Analyzers. Note that a high degree of magnification is used in the sample
electropherograms shown in Figures 13 to 15 on pages 110 to 112.
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Figure 13 Examples of fluorescence background in data produced on an
Applied Biosystems® 3130x/ Genetic Analyzer, (Y-axis scale 0-100 RFU).
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Figure 14 Example of a — 2 nt reproducible artifact at the SE33 locus. Data
produced on an Applied Biosystems® 3130x/ Genetic Analyzer.
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Figure 15 NGM SElect™ kit electropherogram showing plus stutter associated
with the D22S1045 STR locus. Data produced on an Applied Biosystems® 3130x/
Genetic Analyzer.
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Characterization of loci

SWGDAM  “The basic characteristics of a genetic marker must be determined and documented.”
guideline 2.1  (SWGDAM, July 2003)

This section describes basic characteristics of the 15 loci and the sex-determining
marker, Amelogenin, which are amplified with the AmpF{STR® NGM SElect™ Kit.
Most of these loci have been extensively characterized by other laboratories.

Nature of the The primers for the Amelogenin locus flank a 6-nucleotide deletion within intron 1
polymorphisms  of the X homolog. Amplification results in 104-nt and 110-nt products from the X

and Y chromosomes, respectively. (Sizes are the actual nucleotide size according to
sequencing results, including 3" A nucleotide addition, and size may not correspond
exactly to allele mobility observed on capillary electrophoresis platforms.) With the
sole exception of D22S1045, a trinucleotide STR, the remaining AmpF(STR® NGM
SElect™ Kit loci are tetranucleotide short tandem repeat (STR) loci. The length
differences among alleles of a particular locus result from differences in the number
of repeat units.

All the alleles in the AmpF(STR® NGM SElect™ Kit Allelic Ladder, including
microvariants, have been subjected to sequencing. In addition, other groups in the
scientific community have sequenced alleles at some of these loci (Nakahori et al.,
1991; Puers et al., 1993; Moller et al., 1994; Barber et al., 1995; Moller and
Brinkmann, 1995; Barber et al., 1996; Barber and Parkin, 1996; Brinkmann et al.,
1998; Momhinweg et al., 1998; Watson et al., 1998). Among the various sources of
sequence data on the AmpF(STR® NGM SElect™ Kit loci, there is consensus on the
repeat patterns and structure of the STRs.

Inheritance The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from
families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to
characterize the mode of inheritance of various DNA loci. Each family set contains
three generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying
inheritance patterns (Begovich et al., 1992). Observations from the analysis of three
CEPH family genomic DNA sets are noted in “Estimating germ-line mutations” on
page 129.

Mapping The AmpF{STR® NGM SElect™ Kit loci have been mapped, and the chromosomal
locations have been published (Nakahori et al., 1991; Edwards et al., 1992; Kimpton
et al., 1992; Mills et al., 1992; Sharma and Litt, 1992; Li et al., 1993; Straub et al.,
1993; Barber and Parkin, 1996).

Genetic linkage Two sets of STR loci in the AmpF{(STR® NGM SElect™ Kit are located on the same
chromosomes. VWA and D12S391 are located approximately 6.3 million bp apart on
the p arm of chromosome 12, while D2S1338 and D2S441 are located approximately
150 million bp apart on opposite arms of chromosome 2. Linkage disequilibrium
analysis was conducted on the genotype results from 1,034 individuals of three
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ethnic groups (350 African-American, 349 Caucasian, and 335 Hispanic). STR locus
genotype results from the population study were analyzed using the Linkage
Disequilibrium module of GenePop software version 4.0.10 (Raymond and Rousset,
1995; Rousset, 2008). See Table 6 for results.

The relatively high probability values indicate that there is no statistically significant
linkage disequilibrium found between the pairs of loci located on the same

chromosome.

An independent analysis of data from the same collection of population samples
(Budowle, et al., 2010) also concluded that the 15 STR loci shared between the
NGM™ and NGM SElect™ kits were independent at the population level (note that
the SE33 locus was not part of this analysis). Therefore, to calculate the rarity of a
profile for comparison to single-source and mixture samples, the frequencies of all
loci including vWA and D12S391 could be multiplied. However, the analysis of the
CEPH pedigree families demonstrated a degree of linkage between vWA and
D12S391 that does not support the assumption of independence for the purpose of
kindship analysis.

Table 6 GenePop LD Result (p value for pairwise analysis of loci)

Locus Chro;nn::ome Chﬁl:;fes;.m: ,:\r;iﬁiacr;-n Caucasian Hispanic
Positiont  Goorinates’ (N _asg (N=350)  (N=293)
VWA p13.31 5.9
D12S391 p13.2 12.2 0.86 0.29 0.27
D2S441 p14 68
D2S1338 a35 218 0.11 0.32 0.19

¥ STR locus mapping data was obtained from the NCBI Map Viewer
http://www.ncbi.nim.nih.gov/projects/mapview/map_search.cgi?taxid=9606 or the UCSC
Genome Browser (http://genome.ucsc.edu/). GenePop LD analysis probability results (p values)
greater than 0.05 were considered to indicate that linkage disequilibrium between the loci within the
population tested was not statistically significant.
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Species specificity

Species specificity

SWGDAM  “For techniques designed to type human DNA, the potential to detect DNA from
Guideline 2.2 forensically relevant nonhuman species should be evaluated.” (SWGDAM, July
2003)

The AmpF(STR® NGM SElect™ Kit provides the required specificity for detecting
human alleles.

Nonhuman studies

Nonhuman DNA may be present in forensic casework samples. The following
species were tested (in the specified amounts) using standard PCR and capillary
electrophoresis conditions for the AmpF{STR® NGM SElect™ Kit.

* Primates: gorilla, chimpanzee, and macaque (1.0 ng each)

* Non-primates: mouse, dog, sheep, pig, rabbit, cat, horse, hamster, rat, chicken,
and cow (10.0 ng each)

* Microorganisms: Candida albicans, Staphylococcus aureus, Escherichia coli,
Neisseria gonorrhoeae, Bacillus subtilis, and Lactobacillus rhamnosus
(equivalent to 105 copies)

Results were assessed for the presence of any amplified peaks that would indicate
cross reactivity of the NGM SElect’™ kit with any of these non-human species.

Figure 16 on page 116 shows example electropherogram results from the species
specificity tests. The chimpanzee and gorilla DNA samples produced partial profiles
within the 70 to 350 nucleotide region (gorilla data not shown). Macaque DNA
produced a strong Amelogenin X peak and two small PET® dye peaks at 315 and
339 bp.
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Figure 16 Representative electropherograms for some species tested in a
species specificity study including positive and non-template controls (NTC)

Among the non-primate species, most produced no peaks over the 50 RFU threshold.
Horse yielded reproducible VIC® dye peaks at 94 bp (less than 100 RFU) and
individual replicate PCRs of cat, hamster and pig yielded single, small (less than 100
RFU), non-reproducible peaks.
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Sensitivity

SWGDAM
guideline 2.3

Importance of
quantification

Effect of DNA
quantity on
results

“When appropriate, the range of DNA quantities able to produce reliable typing
results should be determined.” (SWGDAM, July 2003)

The recommended amount of input DNA for the AmpF(STR® NGM SElect™ Kit is
1.0 ng for 29-cycle PCR and 0.5 ng for 30-cycle PCR based on quantification using
either the Quantifiler® Human or Quantifiler® Duo Quantification kit; individual
laboratories should determine the optimum input DNA amount according to the
quantification method in use in the laboratory. If the sample contains degraded or
inhibited DNA, amplification of a higher concentration of DNA may be beneficial.
In Figure 17 on page 118, the control DNA 007 was serially diluted from 1.0 ng to
0.031 ng. Full profiles (34 PCR products) were consistently obtained at 0.125 ng, but
occasional partial profiles resulted at lower concentrations. Sensitivity at 30 PCR
cycles was greater than at 29 cycles.

If too much DNA is added to the PCR reaction, the increased amount of PCR product
that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by
the instrument (“off-scale” data).
» Off-scale data. Off-scale data is a problem because:

— Quantification (peak height and area) for off-scale peaks is not accurate.
For example, an allele peak that is off-scale can cause the corresponding
stutter peak to appear higher in relative intensity, thus increasing the
calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy
results in poor spectral separation (“pull-up”).

* Incomplete +A nucleotide addition.
To address these issues, reamplify the sample using less DNA.

When the total number of allele copies added to the PCR is extremely low,
unbalanced amplification of the alleles may occur because of stochastic fluctuation.

Individual laboratories may find it useful to determine an appropriate minimum peak
height threshold based on their own results and instruments using low amounts of
input DNA.
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Figure 17 Electropherograms for amplifications using 1 ng, 0.50 ng, 0.25 ng,
0.125 ng, 0.062 ng, and 0.031 ng of control DNA 007. Electrophoresis was
performed on an Applied Biosystems® 3130x/ Genetic Analyzer. Note that the
Y-axis scale is magnified for the smaller input amounts of DNA.
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SWGDAM
guideline 2.4

Degraded DNA

“The ability to obtain results from DNA recovered from biological samples deposited
on various substrates and subjected to various environmental and chemical insults
has been extensively documented. In most instances, assessment of the effects of
these factors on new forensic DNA procedures is not required. However, if substrates
and/or environmental and/or chemical insults could potentially affect the analytical
process, then the process should be evaluated using known samples to determine the
effects of such factors.” (SWGDAM, July 2003)

As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product generated is reduced because of the reduced number of
intact templates in the size range necessary for amplification.

Degraded DNA was prepared to examine the potential for differential amplification
of loci. High-molecular-weight Raji DNA was sonicated and incubated with
increasing doses of DNase I (0 to 6 Units) for 20 minutes (Bender et al., 2004). The
DNA was examined by agarose gel analysis to determine the average size of the
DNA fragments at each time point.

Amplification of 0.5 ng of degraded DNA using the AmpF(STR® NGM SElect"™ Kit
was performed. As the DNA became progressively degraded, the loci failed to
amplify robustly in order of decreasing size. Preferential amplification was not
observed.
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Figure 18 Amplification of Raji DNA samples sonicated and incubated with
increasing doses of DNase I. Panels 1, 2, 3, 4, and 5 correspond to 0, 3, 4, 5, and
6 units of DNase |. The same set of samples were analyzed with both 29 and 30
PCR cycles (the results shown are from the 30-cycle amplification). Note that the
Y-axis scale is magnified for more degraded samples, which generate lower peak
heights.

Heme compounds have been identified as PCR inhibitors in DNA samples extracted
from bloodstains (DeFranchis et al., 1988; Akane et al., 1994). It is believed that the
inhibitor is co-extracted and co-purified with the DNA and subsequently interferes
with PCR by inhibiting polymerase activity.

To examine the effects of hematin on the performance of the AmpF/(STR® NGM
SElect™ Kit, 0.5 ng of control DNA 007 was amplified in the presence of increasing
concentrations of hematin for 29 and 30 cycles of amplification (Figure 19 on

page 121).The concentrations of hematin used were 0 uM, 50 uM, 150 uM, and
300 uM (see Table 7 on page 121).
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Figure 19 Electropherograms for the AmpF(STR® NGM SElect™ and SEfiler
Plus™ kits show the improved performance of the NGM SElect™ kit in the
presence of hematin compared with previous AmpF(STR® kits. The same set of
inhibited samples was analyzed with the NGM SElect™ kit for both 29 and 30 PCR
cycles of amplification (results shown for both kits are from the 30-cycle
amplification).

Table 7 NGM SElect™ kit performance in simulated hematin inhibition (N = 3)

Hematin Concentration (uM)

Number of Alleles Detected?

0 34,34, 34
50 34,34, 34
150 34,34, 34
300 24,29, 22

I Only those peaks >50 RFU were counted. A complete profile with control DNA 007 yields 34 peaks
using the AmpF(STR® NGM SElect™ Kit.
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Effect of
inhibitors —
humic acid

Traces of humic acid may inhibit the PCR amplification of DNA evidence collected
from soil. Amplification of 1 ng of control DNA 007 in the presence of increasing
amounts of humic acid was performed using the AmpF(STR® NGM SElect™ Kit for
29 and 30 cycles of amplification (see Figure 20). The concentrations of humic acid
tested were 0, 25, 50, and 100 ng/uL (see Table 8 on page 122).
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Figure 20 Electropherograms for the AmpF(STR® NGM SElect™ and SEfiler
Plus™ kits show improved performance of the NGM SElect™ kit in the presence of
humic acid compared to previous AmpF(STR® kits. The same set of inhibited
samples was analyzed with the NGM SElect™ kit for both 29 and 30 PCR cycles
of ampilification (results shown for both kits are from the 30-cycle amplification).

Table 8 NGM SElect™ kit performance in simulated model of humic acid
inhibition (n = 3)

Humic Acid Concentration (ng/pL) Number of Alleles Detected*

0 34,34, 34
25 34,34, 34
50 34,34, 34
100 34,34, 34

I Only those peaks >50 RFU were counted. A complete profile with control DNA 007 yields 34 peaks
using the AmpF(STR® NGM SElect™ Kit.
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Mixture studies

SWGDAM
guideline 2.8

Mixture Studies

“The ability to obtain reliable results from mixed source samples should be
determined.” (SWGDAM, July 2003)

Evidence samples may contain DNA from more than one individual. The possibility
of multiple contributors should be considered when interpreting the results. We
recommend that individual laboratories determine a minimum peak height threshold
based on validation experiments performed in each laboratory to avoid typing when
stochastic effects are likely to interfere with accurate interpretation of mixtures.

Evidence samples that contain body fluids and/or tissues originating from more than
one individual are an integral component of forensic casework. Therefore, it is
essential to ensure that the DNA typing system is able to detect DNA mixtures.
Mixed samples can be distinguished from single-source samples by:

» The presence of more than two alleles at a locus
* The presence of a peak at a stutter position that is significantly greater in
percentage than typically observed in a single-source sample

+ Significantly imbalanced alleles for a heterozygous genotype

The peak height ratio is defined as the height of the lower peak (in RFU) divided by
the height of the higher peak (in RFU), expressed as a percentage. Mean, median,
minimum, and maximum peak height ratios observed for alleles in the AmpF(STR®
NGM SElect™ Kit loci in unmixed population database samples are shown in
Figure 21 on page 124.
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Figure 21 Heterozygote ratios for 1 ng of input DNA. The distribution of
intra-locus peak height ratios are expressed as plus and minus percent, by locus.
Green boxes show the middle 50% or interquartile range (IQR). Box halves below
and above median show the second and third quartile, respectively. “Whiskers”
indicate 1.5 IQR from the upper and lower margins of the IQR. Red diamonds are
outlier data points more than 1.5 IQR from the median.

If an unusually low peak height ratio is observed for one locus, and there are no other
indications that the sample is a mixture, the sample may be reamplified and
reanalyzed to determine if the imbalance is reproducible. Possible causes of
imbalance at a locus are:

* Degraded DNA

* Presence of inhibitors

+ Extremely low amounts of input DNA

* A mutation in one of the primer binding sites

» Presence of an allele containing a rare sequence that does not amplify as
efficiently as the other allele

Resolution of genotypes in mixed samples

A sample containing DNA from two sources can comprise (at a single locus) any of
the seven genotype combinations (see below).
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* Heterozygote + heterozygote, no overlapping alleles
(four peaks)

» Heterozygote + heterozygote, one overlapping allele
(three peaks)

* Heterozygote + heterozygote, two overlapping alleles
(two peaks)

* Heterozygote + homozygote, no overlapping alleles
(three peaks)

* Heterozygote + homozygote, overlapping allele
(two peaks)

* Homozygote + homozygote, no overlapping alleles
(two peaks)

* Homozygote + homozygote, overlapping allele
(one peak)

Specific genotype combinations and input DNA ratios of the samples contained in a
mixture determine whether or not it is possible to resolve the genotypes of the major
and minor component(s) at a single locus.

The ability to obtain and compare quantitative values for the different allele peak
heights on Applied Biosystems® instruments provides additional valuable data to aid
in resolving mixed genotypes.

Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case, including the information provided
from known reference sample(s).

Limit of detection of the minor component

Mixtures of two DNA samples were examined at various ratios (0:1, 1:1, 3:1, 7:1,
15:1, 1:0). The total amount of genomic input DNA mixed at each ratio was 1 ng.
The samples were amplified in a GeneAmp® PCR System 9700, then
electrophoresed and detected using an Applied Biosystems® 3130x/ Genetic
Analyzer.

The results of the mixed DNA samples are shown in Figure 22 on page 126 where
samples A and B were mixed according to the ratios indicated. The minor component
allele calls at non-overlapping loci are highlighted. Detection of full profiles for the
minor contributor was possible at ratios of 3:1 (0.750:0.250 ng) and 7:1
(0.875:0.125 ng). Generally, 15:1 ratios resulted in partial profiles for the minor
component. The profiles of these samples are described in Table 9 on page 127.
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Figure 22 Amplification of DNA mixtures at various ratios. Panels show
electropherograms for (top to bottom) 1:0 (major contributor only), 15:1 mixture,
10:1 mixture, 7:1 mixture, 3:1 mixture, 1:1 mixture, and 0:1 (minor contributor
only).
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Mixture studies

Table 9 Genotypes of mixed DNA samples

Locus Sample A Genotype Sample B Genotype
D10S1248 13,14 12,15
VWA 14,17 17,19
D16S539 10, 11 9,12
D2S1338 17,23 17,20
AMEL XY X
D8S1179 11,14 10,11
D21S11 29, 35 31.2,32.2
D18S51 15,16 13,14
D22S1045 15 15, 16
D19S433 11,17.2 13
THO1 7,8 6,9.3
FGA 19, 25 22,23
D2S441 11,12 11, 14
D3S1358 14,17 15,16
D1S1656 12,18.3 11, 15
D12S391 18, 18.3 18, 22
SE33 19 18,24.2
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Population data

SWGDAM
guideline 2.7

Overview

“The distribution of genetic markers in populations should be determined in relevant
population groups.” (SWGDAM, July 2003)

The AmpF(STR® NGM SElect™ PCR Amplification Kit contains loci for which
extensive population data are available. For additional information on 11 loci shared

between the kits, see the population data and additional studies section of the
AmpF&STR® SGM Plus® PCR Amplification Kit User’s Manual (PN 44309589).

Population samples used in these studies

The AmpF(STR® NGM SElect™ PCR Amplification Kit was used to generate the
population data provided in this section. Whole blood samples, provided by the
Interstate Blood Bank (Memphis, Tennessee) and Boca Biolistics (Coconut Creek,
Florida), were collected in the United States (with no geographical preference) from
randomly-selected individuals of known ethnicities. Ethnicities of sample donors
were:

* African-American — 344 samples
» Caucasian — 346 samples
* Hispanic — 390 samples
DNA was extracted using an ABI PRISM® 6100 Nucleic Acid PrepStation.
In addition to the alleles that were observed and recorded in our databases, other

alleles have been published or reported to us by other laboratories (see the STRBase
at www.cstl.nist.gov/div831/strbase).
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Mutation rate

Mutation rate

Estimating germ-  Estimation of spontaneous or induced germ-line mutation at genetic loci can be
line mutations achieved by comparing the genotypes of offspring to those of their parents. From
such comparisons the number of observed mutations are counted directly.

Genotyping analysis of three CEPH families (1333, 1340, and 1345) was conducted
using the NGM SElect™ kit as part of the developmental validation process. These
three-generation families, comprising 58 meioses altogether, showed three cases of
apparent STR allele repeat number mutations, one in each family. Family 1333 had a
mutation at the D12S391 locus that resulted in a change of allele 25 in a grandmother
(individual 7341) to allele 24 in her daughter (individual 6987). Family 1340 had a
mutation at the D8S1179 locus that resulted in a change of allele 10 in a grandfather
(individual 6994) to allele 11 in his son (individual 7029). Family 1345 had a
mutation at the SE33 locus that resulted in a change of allele 16 in a mother
(individual 7348) to allele 15 in one of her sons (individual 7352). In all cases, the
apparent mutation events resulted in either a gain or loss of a single repeat unit.

In previous studies, genotypes of ten STR loci that were amplified by the
AmpF(STR® SGM Plus® PCR Amplification Kit were determined for a total of 146
parent-offspring allelic transfers (meioses) at the Forensic Science Service,
Birmingham, England. One length-based STR mutation was observed at the D18S11
locus; mutations were not detected at any of the other nine STR loci. The D18S11
mutation was represented by an increase of one 4-nt repeat unit, allele 17 was
inherited as allele 18 (single-step mutation). The maternal/paternal source of this
mutation could not be distinguished.

Additional Additional studies (Edwards et al., 1991; Edwards et al., 1992; Weber and Wong,
mutation studies  1993; Hammond et al., 1994; Brinkmann et al., 1995; Chakraborty et al., 1996;
Chakraborty et al., 1997; Brinkmann et al., 1998; Momhinweg et al., 1998; Szibor et
al., 1998) of direct mutation rate counts produced:

+ Larger sample sizes for some of the AmpF(STR® NGM SElect™ Kit loci.

* Methods for modifications of these mutation rates (to infer mutation rates
indirectly for those loci where the rates are not large enough to be measured
directly and/or to account for those events undetectable as Mendelian errors).
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Probability of identity

Table 10 shows the allele frequencies at AmpF{STR® NGM SElect™ Kit loci by
population group. Table 11 shows the Probability of identity (P,) values of the
AmpF(STR® NGM SElect™ Kit loci individually and combined. The P; value is the
probability that two individuals selected at random will have an identical
AmpF(STR® NGM SElect™ Kit genotype (Sensabaugh, 1982). The P, values for the
populations described in this section are then 8.12 X 10 =22 (African-American),

2.35 X 102! (U.S. Caucasian) and 3.16 X 10 ~2! (U.S. Hispanic).

Table 10 Allele frequencies by population group for AmpF(STR® NGM SElect™
Kit STR loci. (Dashes indicate alleles not detected or, where values appear in

parentheses, alleles not detected in significant quantities.)

Allele African American Caucasian Hispanic
(N = 344) (N = 346) (N = 390)
D10S1248

6 -- (0.15) -- --

7 -- (0.15) - -

8 - - --(0.13)

9 -- (0.15) — --(0.13)

10 -- (0.15) - --(0.13)

11 3.63 --(0.58) --(0.26)

12 13.95 3.47 4.23

13 22.67 29.05 25.51

14 28.2 29.77 36.03

15 18.6 19.65 22.95

16 9.88 13.44 8.08

17 2.18 3.76 2.56

18 -- (0.29) -- (0.29) --

19 -- -- --

20 - - -

D12S391

13 -- -- --(0.13)

14 - - --(0.13)

15 7.12 4.19 3.97
15.1 -- (0.15) - -

16 5.09 3.47 5.13
16.1 -- (0.15) - —

17 15.7 10.55 7.31
17.1 - (0.44) - — (028
17.3 -- (0.58) 2.02 1.15

18 25.73 16.18 20
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Allele African American Caucasian Hispanic
(continued) (N = 344) (N = 346) (N =390)
18.3 1.16 217 2.05

19 141 12.28 18.59
19.1 -- (0.58) - --
19.3 -- (0.29) - (0.58) 1.15
20 11.92 9.83 17.31
20.3 - - -
21 6.98 13.73 8.72
21.3 -- (0.15) - (0.14) --
22 5.09 10.69 6.92
23 3.34 8.09 3.72
24 -- (0.58) 3.61 1.79
25 0.87 2.02 1.28
26 - -- (0.29) - (0.26)
o7 - - (0.14) - (0.13)
28 - - -
D16S539

5 i i -

6 - == -- (0.13)
- n i -

8 3.49 1.45 1.92
9 22.24 12.43 10.38
10 11.63 4.05 15.77
11 29.07 32.23 31.92
12 19.33 30.78 24.49

12.2 -- - -

13 12.94 17.2 13.97
14 1.31 1.73 1.15
15 - - (0.14) --(0.26)
16 -- -- --

D18S51

- n i -

8 » i -

9 - - --(0.13)
9.2 - - -
10 -- (0.29) 1.16 0.64

10.2 -- (0.15) — --

11 — (0.44) 0.87 1.15

1.2 - - -
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Allele African American Caucasian Hispanic
(continued) (N = 344) (N = 346) (N =390)
12 6.25 14.74 10.77
12.2 -- - -
13 4.07 11.85 11.54
13.2 - (0.29) -- --
14 5.81 17.49 15.77
14.2 - (0.44) - - (0.13)
15 17.3 15.32 12.31
15.2 -- -- - (0.13)
16 18.31 11.85 12.82
16.2 -- - -
17 15.7 10.98 17.05
17.2 -- - -
18 14.1 8.53 8.46
18.2 -- - -
19 9.16 4.34 3.46
19.2 -- - -
20 4.22 1.3 1.79
20.2 --(0.15) -- --
21 2.03 1.01 2.31
21.2 -- - -
22 1.02 -- (0.29) 0.64
22.2 -- - -
23 -- (0.29) -- (0.29) -- (0.51)
23.2 -- - -
24 - - -- (0.26)
o5 - - - (0.13)
26 -- - -
27 -- - -
D19S433
9 -- (0.29) -- --
9.2 -- - -
10 1.16 - (0.14) -- (0.38)
10.2 -- (0.15) -- --

11 9.74 - 1.54
11.2 -- (0.29) - --(0.26)
12 10.76 7.23 8.46
12.1 - - (0.14) -
12.2 3.78 --(0.14) 1.41
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Allele African American Caucasian Hispanic
(continued) (N = 344) (N = 346) (N =390)
13 28.63 27.46 18.72
13.2 5.23 1.59 7.05
14 18.31 34.68 30.38
14.2 5.81 217 4.49
15 6.25 16.18 12.69
15.2 4.22 3.47 7.31
16 1.45 5.92 4.1
16.2 3.34 -- (0.29) 2.31
17 - -- (0.29) -- (0.51)
17.2 -- (0.58) - (0.14) -- (0.38)
18 - -- (0.14) --
18.2 - - -
D1S1656
9 - (0.15) -- - (0.13)
10 1.31 --(0.29) --(0.38)
11 5.52 5.92 3.85
12 7.99 16.04 9.49
13 11.19 6.65 7.18
14 24.27 6.36 11.03
14.3 1.02 -- (0.29) -- (0.26)
15 17.44 15.17 16.03
15.3 1.89 8.53 2.95
16 10.32 9.97 15.26
16.1 -- = --(0.26)
16.3 7.27 4.91 5.26
17 2.62 4.91 6.92
17.1 - --(0.29) -
17.3 5.96 12.72 15.26
18 -- (0.44) -- (0.29) 0.77
18.3 1.89 5.92 4.36
19 --(0.15) -- --
19.3 -- (0.58) 1.73 0.64
20.3 -- - -
D21S11
23.2 -- - -
24 == - -
24.2 - - -- (0.26)
25 - - -
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Allele African American Caucasian Hispanic
(continued) (N = 344) (N = 346) (N =390)
25.2 -- - -
26 -- (0.29) -- (0.58) --(0.38)
26.2 -- - -
27 5.52 2.75 1.41
27.1 -- (0.15) -- --
27.2 -- - -
28 25.29 16.91 11.03
28.2 -- -- - (0.13)
29 15.7 23.55 21.15
29.2 == --(0.14) -
29.3 -- (0.15) --(0.14) -
30 20.93 23.41 27.95
30.2 1.6 2.75 1.67
31 8.72 6.79 5
31.2 4.94 8.67 11.28
32 1.31 2.31 1.28
32.2 6.98 9.54 12.44
33 0.87 - --(0.13)
33.2 3.2 2.02 5.26
34 - (0.15) -- -
34.2 -- -- (0.43) --(0.13)
35 3.49 -- -- (0.26)
35.2 -- - -
36 0.73 -- --(0.13)
36.2 -- - -
37 -- - -
37.2 -- - -
38 - - - (0.13)
38.2 -- - -
39 -- - -
D22S1045
5 - - -
5 _ _ -
= - _ -
8 0.73 - --
9 - - -
10 4.07 -- (0.43) 0.64
11 14.53 13.58 7.82
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Allele African American Caucasian Hispanic
(continueq) (N = 344) (N = 346) (N = 390)
12 5.96 --(0.58) 1.03
13 --(0.29) 1.01 1.03
14 8.58 3.47 2.18
15 23.55 36.56 42.56
16 19.91 36.27 35.64
17 20.35 7.51 7.95
18 2.03 --(0.58) 1.03
20 —- — --(0.13)
D251338
13 --(0.15) - (0.14) -
14 - - (0.14) -
15 -- (0.29) - (0.14) -
16 5.23 4.19 3.59
17 10.03 18.79 17.69
18 4.8 8.38 6.54
19 15.99 14.31 17.82
20 10.03 15.46 13.72
21 12.79 2.75 3.59
22 12.65 1.73 6.28
23 9.3 10.12 14.87
24 8.58 9.97 8.85
25 6.98 11.85 5.38
26 2.47 1.73 1.41
27 0.73 --(0.29) --(0.13)
28 - - --(0.13)
29 == == --
D2S441
8 --(0.15) — =
9 -- -- (0.58) -- (0.26)
10 8.87 19.8 31.15
11 35.03 33.82 31.67
11.3 3.34 5.06 4.36
12 20.06 4.05 3.97
12.3 --(0.15) --(0.29) --(0.38)
13 3.63 3.18 1.92
13.3 = == ==
14 26.89 28.32 22.56
14.3 == == ==
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Allele African American Caucasian Hispanic
(continued) (N = 344) (N = 346) (N =390)
15 1.89 4.48 3.33
16 -- -- (0.43) -- (0.38)
17 -- -- --
D3S1358
9 --(0.29) -- --(0.13)
11 -- -- (0.29) --
12 -- (0.15) -- --(0.13)
13 -- (0.58) -- (0.14) -- (0.38)
14 9.16 15.17 9.49
15 28.34 27.31 34.49
15.2 --(0.29) -- --
16 32.85 23.99 26.54
16.2 -- -- --
17 22.09 19.8 17.95
17.2 - - --
18 5.81 11.85 10.13
18.2 -- -- --
19 -- (0.44) 1.45 0.77
20 -- -- --
D8S1179
7 - - -
8 -- (0.44) 2.02 0.64
9 --(0.29) 1.3 -- (0.26)
10 3.34 10.84 9.49
11 5.81 6.65 4.87
12 11.05 15.03 12.44
13 18.31 33.53 33.33
14 36.05 18.64 23.46
15 17.73 8.67 11.54
16 5.96 2.89 3.33
17 1.02 -- (0.43) 0.64
18 -- -- --
19 -- -- --
20 == — —
FGA
16 -- --(0.14) --
16.1 --(0.29) - --
16.2 -- -- --
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Allele African American Caucasian Hispanic
(continued) (N = 344) (N = 346) (N =390)

17 - - (0.14) -
17.2 == - | -

18 0.87 1.16 0.64
18.2 0.73 -- -

19 6.83 5.35 7.82
19.2 -- (0.44) - --

20 6.69 15.61 8.72
20.2 -- (0.29) -- (0.43) -- (0.26)

21 12.06 18.35 13.59
21.2 -- (0.15) --(0.29) --

22 18.17 18.93 141
eer. -- (0.15) 0.87 0.64

23 16.86 14.6 12.69
23.2 -- -- (0.43) --(0.38)
23.3 -- (0.29) -- -

24 18.75 14.31 15.9
24.2 -- - -

25 9.3 6.79 141
25.2 - - -

26 3.92 1.88 6.79
26.2 -- - -

27 2.62 -- (0.58) 2.95
27.2 - - -

28 1.16 -- (0.14) 0.9
28.2 -- - -

29 - -- -- (0.38)
29.2 -- - -

30 -- (0.15) - - (0.13)
30.2 -- (0.15) - -

31 - - -
31.2 - - -

32 - - -
32.2 -- - -
33.2 == - -
34.2 --(0.15) -- -
42.2 = - -
43.2 -- - -
44.2 == - -
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Allele African American Caucasian Hispanic
(continued) (N = 344) (N = 346) (N = 390)

452 - - -
46.2 - - | -
472 - - -
48.2 - - -
49.2 - - -
50.2 - - -
51.2 - - -

SE33
4.2 - - —

5 - - -
5.2 - (0.15) - -
6 - - -
6.3 - -~ (0.14) -

8.2 = = =5

9.2 -- - -
10 - - -
10.2 — — -
11 - - -
11.2 0.73 = - (0.13)
12 - (0.15) - (0.43) --(0.13)
12.1 -- -- (0.14) =
12.2 - (0.29) - (0.14) - (0.13)
13 1.31 0.87 1.15
13.2 -- (0.44) - -- (0.13)
14 3.63 3.76 1.92
14.2 - - 0.77
14.3 = -- (0.14) -

15 3.92 3.61 4.74
15.2 -- (0.29) -- (0.14) --(0.13)
16 6.98 5.2 5.51
16.2 -- (0.29) - -- (0.26)
16.3 - - --(0.13)
17 7.7 6.5 8.72
17.2 - (0.15) - -
17.3 - -- (0.14) -
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Allele African American Caucasian Hispanic
(continued) (N = 344) (N = 346) (N = 390)
18 11.05 8.24 10
18.2 --(0.15) — -- (0.26)
19 15.26 8.09 7.95
19.2 -- (0.29) -- (0.29) -
19.3 - -- (0.43) --
20 9.3 4.91 4.49
20.2 0.87 0.87 0.77
21 5.81 2.02 3.33
211 -- -- --
21.2 1.02 1.16 1.28
22 1.74 --(0.58) 1.03
22.2 1.45 3.32 2.18
23 -- (0.29) - -
23.2 --(0.58) 2.6 2.69
23.3 -- - - (0.13)
24 --(0.29) --(0.14) --(0.13)
24.2 1.6 4.48 2.18
25 = = =
25.2 2.33 3.9 3.46
26 --(0.15) — -- (0.26)
26.2 5.67 4.19 6.92
27 == == ==
27.2 5.81 7.08 6.79
27.3 -- - --(0.13)
28 - - -
28.2 4.07 7.8 5.9
29 -- -- --
29.2 2.47 7.8 6.28
30 -- - --
30.2 1.45 4.91 3.97
31 - - --(0.13)
31.2 1.02 2.89 2.18
32 -- -- (0.43) --
32.2 0.73 1.59 2.05
33 - --(0.29) --(0.38)
33.2 -- (0.44) - (0.14) -- (0.51)
34 - --(0.29) --(0.38)
34.2 --(0.15) — -- (0.26)
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Allele African American Caucasian Hispanic
(continued) (N = 344) (N = 346) (N =390)
35 -- --(0.14) -
35.2 - - -

36 -- - (0.14) ="
36.2 - - -

37 - - --(0.13)
37.2 - - -
38 - - -

THO1

-- (0.44) --(0.14) --
5.3 == - -

6 15.41 21.68 27.95
6.1 -- (0.15) -- -
6.3 -- - -

7 37.06 17.77 31.92
7.3 - - -

8 21.22 11.42 8.46
8.3 -- - -

9 15.84 17.05 12.56
9.3 8.43 31.07 17.69
10 1.45 0.87 1.41
10.3 -- - -

11 -- -- -

12 -- - -

13 - - -
13.3 -- - -

VWA

10 -- - -

11 -- (0.44) - - (0.13)
12 — - -- (0.26)
13 0.73 - (0.14) - (0.13)
14 7.41 8.38 6.41
15 20.93 12.14 9.87
15.2 - - -

16 27.47 22.69 30
17 19.48 27.31 27.18
17.3 -- -- - (0.13)
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Allele African American Caucasian Hispanic
(continued) (N = 344) (N = 346) (N = 390)
18 13.81 18.06 18.46
18.2 -- -- --

19 6.98 9.97 6.67

20 2.038 1.3 0.77

21 -- (0.58) - --

22 - — -

23 -- (0.15) - -

24 — — —

25 - - -
Table 11  Probability of identity (P, values for the AmpF(STR® NGM SElect™ Kit
STR loci

Locus African-American Caucasian Hispanic
N = 344 N = 346 N =390

D10S1248 0.0695 0.0937 0.1114

D12S391 0.0392 0.0232 0.0319

D16S539 0.0717 0.1042 0.0816

D18S51 0.0314 0.0312 0.0279
D19S433 0.0396 0.0852 0.0478
D1S1656 0.0335 0.0224 0.0247
D21S11 0.0454 0.0520 0.0502
D22S1045 0.0556 0.1326 0.1611
D2S1338 0.0226 0.0316 0.0318
D2S441 0.1014 0.0980 0.1068
D3S1358 0.0998 0.0749 0.0952
D8S1179 0.0755 0.0635 0.0682
FGA 0.0327 0.0387 0.0283
SE33 0.0121 0.0085 0.0079
THO1 0.0944 0.0798 0.0905
VWA 0.0617 0.0654 0.0913
Combined 8.12xe =22 2.35xe~? 3.16 x e =2
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Probability of paternity exclusion

Table 12 shows the Probability of paternity exclusion (Pg) values of the AmpF/(STR®
NGM SElect™ Kit STR loci individually and combined.

Table 12 Probability of paternity exclusion values for the AmpF(STR® NGM
SElect™ Kit STR loci

Locus African-American Caucasian Hispanic
N = 344 N = 346 N =390
D10S1248 0.6590 0.5680 0.4690
D12S391 0.7450 0.7990 0.6620
D16S539 0.5560 0.5790 0.5570
D18S51 0.7860 0.7580 0.7180
D19S433 0.6360 0.5070 0.6470
D1S1656 0.7450 0.8110 0.7230
D21S11 0.7270 0.7290 0.6920
D22S1045 0.6980 0.4550 0.3970
D2S1338 0.7980 0.7520 0.7380
D2S441 0.5250 0.4970 0.4770
D3S1358 0.4760 0.5220 0.4820
D8S1179 0.5870 0.6160 0.5570
FGA 0.7270 0.6660 0.7080
SE33 0.8630 0.9120 0.8690
THO1 0.5150 0.5020 0.5390
VWA 0.6030 0.6440 0.6380
PEi 9.451788e~%° 1.455231¢ 08 8.163126e %8
Combined 0.9999999905 0.9999999854 0.9999999184

The P, value is the probability, averaged over all possible mother-child pairs, that a
random alleged father will be excluded from paternity after DNA typing using the
AmpF/STR® NGM SElect™ Kit STR loci (Chakraborty, Stivers, and Zhong, 1996).
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that

occur during analysis.

Observation

Possible causes

Recommended actions

Faint or no signal from
both the 007 control
DNA and the DNA test
samples at all loci

Incorrect volume or absence of either
AmpF(STR® NGM SElect™ Master
Mix or AmpF(STR® NGM SElect™
Primer Set

Repeat amplification using correct reagent
volumes.

No activation of enzyme

Repeat amplification, making sure to hold reactions
initially at 95 °C for 11 min.

Master Mix not vortexed thoroughly
before aliquoting

Vortex Master Mix thoroughly.

AmpF(STR NGM SElect™ Primer Set
exposed to too much light

Store Primer Set protected from light.

GeneAmp® PCR System malfunction

Refer to the thermal cycler user's manual and
check instrument calibration.

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler
parameters.

Tubes/plate not seated tightly in the
thermal cycler during amplification

Push reaction tubes/plate firmly into contact with
block after first cycle. Repeat test.

Wrong PCR reaction tubes or plate

Use Applied Biosystems® MicroAmp® Reaction.
Tubes with Caps or the MicroAmp® Optical 96-Well
Reaction Plate for the GeneAmp® PCR System
9700 or Veriti® 96-Well Thermal Cycler.

MicroAmp® Base used with
tray/retainer set and tubes in
GeneAmp® PCR System 9700

Remove MicroAmp® Base from tray/retainer set
and repeat test.

Insufficient PCR product
electrokinetically injected

Mix 1.0 uL of PCR product and 10 uL of Hi-Di™
Formamide/GeneScan 600 LIZ™ Size Standard
v2.0 solution.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di™ Formamide.
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Observation

Possible causes

Recommended actions

Positive signal from
AmpF(STR® Control
DNA 007 but partial or
no signal from DNA test
samples

Quantity of test DNA sample is below
assay sensitivity

Quantify DNA and add 1.0 ng of DNA. Repeat test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds, certain
dyes

Quantify DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or use
the AmpF(STR® MiniFiler™ kit.

Dilution of test sample DNA in water or
wrong buffer (for example, TE formula
with incorrect EDTA concentration)

Redilute DNA using low TE Buffer (with 0.1 mM
EDTA).

More than two alleles
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Amplification of stutter product

Mixed sample

Interpret according to laboratory procedures.

Note: Additional information will be provided on
completion of validation.

Incomplete 3" A base addition
(n-1 nt position)

Addition of excess DNA to the reaction will
contribute to the occurrence of incomplete 3'
base addition. Quantify DNA and add 1.0 ng of
DNA to the reaction. Repeat test. Also be sure to
include the final extension step of 60 °C for

10 min in the PCR.

Signal exceeds dynamic range of
instrument (off-scale data)

Ensure that you use the correct cycle number.
Repeat PCR ampilification using the
recommended cycle number or reduce the
amount of input DNA.

Poor spectral separation (bad matrix)

Follow the steps for creating a spectral file.

Confirm that Filter Set G5 modules are installed
and used for analysis.

Too much DNA in reaction

Use recommended amount of template DNA
(1.0 ng).

Incomplete denaturation of double
stranded DNA

Use the recommended amount of Hi-Di™
Formamide and perform heat denaturation
according to instructions on page 37 (3100/3100-
Avant or 3130/3130x/) or page 40 (3500/3500xL).

Poor peak height Incorrect thermal cycler parameters Check the protocol for correct thermal cycler
balance parameters.
GeneAmp® PCR System 9700 with Use Applied Biosystems® GeneAmp® PCR
Aluminum 96-Well block or third- System 9700 with silver or gold-plated silver
party thermal cyclers blocks or Veriti® 96-Well Thermal Cycler only.
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How to order

AmpF(STR® NGM
SElect™ PCR
Amplification Kit

To order kits and supplies, go to www.appliedbiosystems.com.

The table below lists the AmpF(STR® NGM SElect™ PCR Amplification Kits
available. For information on kit contents and storage, see “Kit contents and storage’
on page 17.

Table 13 AmpF(STR® NGM SElect™ PCR Amplification Kits

>

Kit Number ?f 25uL Part number
reactions
AmpF(STR® NGM SElect™ PCR 200 4457889
Ampilification Kit 1,000 4457890

IMPORTANT! The fluorescent dyes attached to the primers in the kit are
light-sensitive. Protect the primer set from light when not in use. Amplified DNA,
AmpF(STR® NGM SElect™ Allelic Ladder, and GeneScan™ 600 LIZ™ Size
Standard v2.0 should also be protected from light. Keep freeze-thaw cycles to a
minimum.

Materials and equipment not included

Table 14 Equipment

Tables 14 and 15 list required and optional equipment and materials not supplied
with the AmpF(STR® NGM SElect™ Kit. Unless otherwise noted, many of the items
are available from major laboratory suppliers (MLS).

Equipment Source

Applied Biosystems® 3500/3500xL Genetic Analyzer for Human Identification Contact your local

Applied Biosystems

ABI PrismM® 3100/3100-Avant Genetic Analyzer sales representative

Applied Biosystems® 3130/3130x/ Genetic Analyzer

Silver 96-Well GeneAmp® PCR System 9700 (with silver sample block) N8050001
Gold-plated 96-Well GeneAmp® PCR System 9700 (with gold-plated silver sample block) 4314878
Silver 96-Well Sample Block N8050251
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Table 14 Equipment

Equipment (continued) Source
Gold-plated Silver 96-Well Sample Block 4314443
Veriti® 96-Well Thermal Cycler 4375786
ProFlex™ 96-Well PCR System 4484075
Tabletop centrifuge with 96-Well Plate Adapters (optional) MLS

Table 15 User-supplied materials*

Item Source

3500/3500xL Analyzer materials

Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4™ polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4™ polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715

®

For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems
3500/3500xL Genetic Analyzer User Guide (PN 4401661).

3100/3100-Avant Analyzer materials

96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3100-Avant Genetic Analyzer Capillary Array, 36 cm 4333464
POP-4™ Polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96 well 4316471
GeneScan™ 600 LIZ™ Size Standard v2.0 4408399
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Materials and equipment not included

Table 15 User-supplied materials*

Item Source
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate N8010560
250 pL Glass Syringe (array-fill syringe) 4304470
5.0 mL Glass Syringe (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100 instrument, refer to Appendix B of the ABI Prism® 3100
Genetic Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (PN 4335393).

3130/3130x/ Analyzer materials

96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x/ Genetic Analyzer Capillary Array, 36 cm 4315931
POP-4™ Polymer for 3130/3130x/ Genetic Analyzers 4352755
3130/3130x/ Genetic Analyzer Autosampler Plate Kit, 96 well 4316471
GeneScan™ 600 LIZ™ Size Standard v2.0 4322682
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate N8010560

For a complete list of parts and accessories for the 3130x/ instrument, refer to Appendix A of the Applied Biosystems®

3130/3130xI Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (PN 4352716).
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Table 15 User-supplied materials*

Item Source
PCR Amplification
MicroAmp® 96-Well Tray N8010541
MicroAmp® Reaction Tube with Cap, 0.2 mL N8010540
MicroAmp® 8-Tube Strip, 0.2 mL N8010580
MicroAmp® 8-Cap Strip N8010535
MicroAmp® 96-Well Tray/Retainer Set 403081
MicroAmp® 96-Well Base N8010531
MicroAmp® Clear Adhesive Film 4306311
MicroAmp® Optical Adhesive Film 4311971
MicroAmp® Optical 96-Well Reaction Plate N8010560
Hi-Di™ Formamide, 25 mL 4311320
Other user-supplied materials
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50 mL Falcon® MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCL, pH 8.0 MLS
EDTA, 0.5 M MLS
Vortex MLS

I For the Safety Data Sheet (SDS) of any chemical not distributed by us, contact the chemical manufacturer. Before handling any
chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
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Safety

This appendix covers:

B Chemical safety.......... ... . e 152
B Chemical wastesafety.......... ... ..., 154
B Biological hazardsafety ........... ... ... .. ... i 156
B Chemicalalerts ......... ... .. 157
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Chemical safety

Chemical hazard WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer
warning to the Safety Data Sheet (SDS) provided by the manufacturer, and observe all
relevant precautions.

A WARNING! CHEMICAL HAZARD. All chemicals in the instrument,
including liquid in the lines, are potentially hazardous. Always determine what
chemicals have been used in the instrument before changing reagents or
instrument components. Wear appropriate eyewear, protective clothing, and
gloves when working on the instrument.

A WARNING! CHEMICAL STORAGE HAZARD. Never collect or store
waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover fastened
and the handles locked in the upright position. Wear appropriate eyewear,
clothing, and gloves when handling reagent and waste bottles.

Chemical safety To minimize the hazards of chemicals:

guidelines * Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. (See “About SDSs” on page 152.)

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the SDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the SDS.

» Comply with all local, state/provincial, or national laws and regulations related
to chemical storage, handling, and disposal.

About SDSs Chemical manufacturers supply current Safety Data Sheets (SDSs) with shipments
of hazardous chemicals to new customers. They also provide SDSs with the first
shipment of a hazardous chemical to a customer after an SDS has been updated.
SDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new SDS packaged with a hazardous chemical, be sure to
replace the appropriate SDS in your files.
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Chemical safety

Obtaining The SDSs for any chemical supplied by us is available to you free 24 hours a day. To
SDSs  obtain SDSs:

1. Go to www.appliedbiosystems.com, click Support, then select SDS.

2. In the Keyword Search field, enter the chemical name, product name, SDS part
number, or other information that appears in the SDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of
the following:

* Open — To view the document
* Print Target — To print the document

» Save Target As — To download a PDF version of the document to a
destination that you choose

Note: For the SDSs of chemicals not distributed by us, contact the chemical
manufacturer.
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Chemical waste safety

Chemical waste A WARNING! HAZARDOUS WASTE. Refer to Safety Data Sheets and local

hazards

regulations for handling and disposal.

WARNING! CHEMICAL WASTE HAZARD. Wastes produced by Applied
Biosystems instruments are potentially hazardous and can cause injury, illness,
or death.

é WARNING! CHEMICAL STORAGE HAZARD. Never collect or store

waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover fastened
and the handles locked in the upright position. Wear appropriate eyewear,
clothing, and gloves when handling reagent and waste bottles.

Chemical waste To minimize the hazards of chemical waste:

safety guidelines

Read and understand the Safety Data Sheets (SDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle,
or dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste
material and meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the SDS.

Handle chemical wastes in a fume hood.
After emptying a waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with
good laboratory practices and local, state/provincial, or national environmental
and health regulations.

Waste disposal If potentially hazardous waste is generated when you operate the instrument, you
must:

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.
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Chemical waste safety

Ensure that the instrument waste is stored, transferred, transported, and disposed
of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Biological hazard safety

General WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

biohazard infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial,
and/or national regulations. Wear appropriate protective equipment, which
includes but is not limited to: protective eyewear, face shield, clothing/lab coat,
and gloves. All work should be conducted in properly equipped facilities using
the appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and
company/institution requirements before working with potentially infectious
materials. Read and follow the applicable guidelines and/or regulatory
requirements in the following:

* U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
http://www.cdc.gov/biosafety/publications/index.htm.

*  Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:
www.cdc.gov
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Chemical alerts

Chemical alerts

For the definitions of the alert words IMPORTANT, CAUTION, WARNING, and
DANGER, see “Safety alert words” on page 7.

General alerts for  Avoid contact with skin, eyes, and/or clothing. Read the SDS and follow the handling
all chemicals instructions. Wear appropriate protective eyewear, clothing, and gloves.
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Documentation

Related documentation

For additional documentation, see “Obtain support” on page 160.

Document title Part

number
Applied Biosystems® 3100/3100-Avant Data Collection v2.0 User Guide 4347102
Applied Biosystems® 3100/3100-Avant Genetic Analyzers Using Data 4350218

Collection Software v2.0 User Bulletin

Applied Biosystems® 3100 Genetic Analyzer User Manual (Data Collection 4315834
vi.i)

Applied Biosystems® 3100/3100-Avant Genetic Analyzers: Protocols for 4332345
Processing AmpF&TR® PCR Amplification Kit PCR Products User Bulletin

AmpFSTR® NGM SElect™ PCR Amplification Kit - PCR Setup Quick 4458842
Reference Card

AmpFSTR® NGM SElect™ PCR Amplification Kit - PCR Amplification and CE | 4458843
Quick Reference Card

Veriti® 96-Well Thermal Cycler AmpF STR® Kit Validation User Bulletin 4440754

ProFlex™ PCR System Kit Validation User Bulletin 100031595

Applied Biosystems® 3130/3100x! Genetic Analyzers Using Data Collection 4363787
Software v3.0 User Bulletin

Applied Biosystems® 3130/3130x! Genetic Analyzers Getting Started Guide 4352715

Applied Biosystems® 3130/3130x! Genetic Analyzers Maintenance, 4352716
Troubleshooting, and Reference Guide

Applied Biosystems® 3130/3130xI Genetic Analyzers Quick Reference Card | 4362825

Applied Biosystems® 3730/3730xI DNA Analyzers and 3130/3130x/ Genetic 4359472
Analyzers: AB Navigator Software Administrator Guide

Applied Biosystems® 3130/3100xI DNA Analyzers User Guide 4331468

Applied Biosystems® 3730/3730xI Genetic Analyzer Getting Started Guide 4359476

PrepFiler™ Forensic DNA Extraction Kit User Guide 4390932

GeneMapper® ID Software Version 3.1 Human Identification Analysis User 4338775
Guide

Installation Procedures and New Features for GeneMapper® ID Software v3.2 | 4352543
User Bulletin
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Documentation

Document title nuFr,:]lr)-ter
GeneMapper® ID-X Software Version 1.0 Getting Started Guide 4375574
GeneMapper® ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper® ID-X Software Version 1.0.1/v1.1 Reference Guide 4375671

GeneMapper® ID-X Software Version 1.1 (Mixture Analysis) Getting Started 4396773

Guide

GeneMapper® ID-X Software Version 1.1 (Mixture Analysis) Quick Reference | 4402094

Guide

Obtain support

For HID support:

In North America — Send an email to HIDTechSupport@lifetech.com, or call
888.821.4443 option 1.

Outside North America — Contact your local support office.

For the latest services and support information for all locations, go to:

www.lifetechnologies.com

At the website, you can:

Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

Search through frequently asked questions (FAQs)
Submit a question directly to Technical Support

Search for user documents, SDSs, vector maps and sequences, application
notes, formulations, handbooks, certificates of analysis, citations, and other
product support documents

Obtain information about customer training
Download software updates and patches

Limited Product Warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set
forth in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies’ website at www.lifetechnologies.com/termsandconditions. If you
have any questions, please contact Life Technologies at
www.lifetechnologies.com/support.
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